User’s Manual
Advanced Structural Concepts, Inc. owns both the NONLIN software program and its documentation. Both the program and documentation are copyrighted with all rights reserved by Advanced Structural Concepts, Inc. No part of this publication may be produced, transmitted, transcribed, stored in a retrieval system, or translated into any language in any form without the written permission from Advanced Structural Concepts, Inc.

While every precaution has been taken to in the preparation of this documentation, the author assumes no responsibility for errors or omissions, or for damages from the use of information contained in this document or from the use of programs or source code that may accompany it. In no event shall the author be liable for any loss of profit or any other commercial damage caused or alleged to have been caused directly or indirectly by this document.

Printed: December 2003 in Blacksburg, Virginia.

Copyright © 2003 Advanced Structural Concepts, Inc. All rights reserved.

Advanced Structural Concepts, Inc.
P.O. Box 990
Blacksburg, VA 24063
USA

Microsoft, Windows, and the Windows logo are registered trademarks of Microsoft Corp. Windows NT is a trademark of Microsoft Corp.

Other brand names and product names referred to are trademarks or registered trademarks of their respective owners.

December, 2003
Contents

ABOUT THE USER’S MANUAL .........................................................................................................................1

WELCOME TO NONLIN .................................................................................................................................2

WHAT IS NONLIN? ........................................................................................................................................2
PROGRAM DESIGN AND CONCEPTS ..............................................................................................................2
SYSTEM REQUIREMENTS .................................................................................................................................3
INSTALLING NONLIN USING THE SETUP UTILITY .....................................................................................3

PART ONE: NONLIN SDOF Systems - Program Data Input

DESCRIPTION OF THE USER INTERFACE ....................................................................................................6

THE MENU ITEMS .....................................................................................................................................7
THE BUTTON BAR .................................................................................................................................13
Structure Restore Button .........................................................................................................................13
NO GO/GO Analysis Buttons ..................................................................................................................13
View Computed Time Histories Button .................................................................................................13
View Computed Hysteresis Plots Button ................................................................................................14
View Computed Energy Plots Button .......................................................................................................14
Review Summary of Computed Results Button ....................................................................................14
Animate Button .....................................................................................................................................14
Response Spectrum Plot Button ...........................................................................................................15
Displacement Ductility Spectra Plot Button ..........................................................................................15

ENTERING STRUCTURAL PROPERTIES .................................................................................................16

THE UNIT TYPE, LENGTH UNITS AND FORCE UNITS FRAMES .............................................................16
THE CONSTITUTIVE PROPERTIES FRAME ..............................................................................................16
Structural Mass/Weight/Period Button ....................................................................................................17
Structural Damping Button ....................................................................................................................17
Structural Stiffness $K_0$ Button ...............................................................................................................18
Structural Strain Hardening Stiffness $K_2$ Button ...................................................................................19
P-Delta Stiffness KG Button ....................................................................................................................19
Yield Strength $F_y$ Button .......................................................................................................................21
Linear/Nonlinear Analysis Options ..........................................................................................................21

DYNAMIC PROPERTIES OUTPUT FRAME ..............................................................................................22
SUMMARY OF LATEST RUN OUTPUT FRAME ..........................................................................................22
DYNAMIC FORCE APPLIED AS... INPUT FRAME .................................................................................23
Defining a Ground Acceleration ................................................................................................................23
Displaying Ground Acceleration Plots ...................................................................................................26
Generating and Displaying Response Spectrum Plots ...........................................................................27
Generating and Displaying Demand Spectrum Plots .............................................................................29
Code Spectra Plots ..................................................................................................................................30
Generating and Displaying Fourier Amplitude Spectrum Plots ............................................................31
Defining a Wave Forcing Function ..........................................................................................................34
Displaying Wave Generator Plots ..........................................................................................................36
Free Vibration .........................................................................................................................................36

PART TWO: NONLIN SDOF Systems - Program Results Output

PROGRAM EXECUTION RESULTS ...............................................................................................................39

RUNNING THE ANALYSIS ..........................................................................................................................39
<table>
<thead>
<tr>
<th>PART THREE: NONLIN MDOF Systems - Advanced Modeling Capabilities</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTRODUCTION ..........................................................................</td>
</tr>
<tr>
<td>THEORETICAL DESCRIPTION ..................................................</td>
</tr>
<tr>
<td>STRUCTURAL IDEALIZATION ..................................................</td>
</tr>
<tr>
<td>HYSTERETIC MODELING .......................................................</td>
</tr>
<tr>
<td>DAMPING ...............................................................................</td>
</tr>
<tr>
<td>LOADING ...............................................................................</td>
</tr>
<tr>
<td>SOLUTION .............................................................................</td>
</tr>
<tr>
<td>USING MDOF-NONLIN ............................................................</td>
</tr>
<tr>
<td>ACCESSING THE MDOF-NONLIN MODEL ....................................</td>
</tr>
<tr>
<td>The Menu Bar ..........................................................................</td>
</tr>
<tr>
<td>Units ....................................................................................</td>
</tr>
<tr>
<td>The Tool Bar ..........................................................................</td>
</tr>
<tr>
<td>Structure Type Panel ..........................................................</td>
</tr>
<tr>
<td>ENTERING STRUCTURAL PROPERTIES .......................................</td>
</tr>
<tr>
<td>REVIEWING PROPERTIES PRIOR TO ANALYSIS ..........................</td>
</tr>
<tr>
<td>DYNAMIC PROPERTIES ..........................................................</td>
</tr>
<tr>
<td>SUMMARY TABLES .....................................................................</td>
</tr>
<tr>
<td>ESTABLISHING LOADING FUNCTIONS ......................................</td>
</tr>
<tr>
<td>RUNNING THE ANALYSIS .......................................................</td>
</tr>
<tr>
<td>VIEWING THE RESULTS ........................................................</td>
</tr>
<tr>
<td>SAVING DATA TO FILE ..........................................................</td>
</tr>
<tr>
<td>RETURNING TO NONLIN SDOF ENVIRONMENT ...........................</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PART FOUR: NONLIN - Incremental Dynamic Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTRODUCTION ..............................................................</td>
</tr>
<tr>
<td>ACCESSING THE IDA ENVIRONMENT .................................</td>
</tr>
<tr>
<td>DATA INPUT FOR IDA ANALYSIS ........................................</td>
</tr>
<tr>
<td>RUNNING THE IDA ANALYSIS AND INTERPRETING THE RESULTS</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PART FIVE: NONLIN - Dynamic Response Tools</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTRODUCTION ......................................................</td>
</tr>
<tr>
<td>ACCESSING THE DRT ENVIRONMENT ..........................</td>
</tr>
<tr>
<td>INPUT PARAMETERS FOR DRT TOOL .............................</td>
</tr>
<tr>
<td>VIEWING THE RESULTS ...............................................</td>
</tr>
</tbody>
</table>

| REFERENCES ..............................................................| 89 |
| ACKNOWLEDGEMENTS .....................................................| 90 |
About the User’s Manual

This User’s Guide contains an introduction to NONLIN features and environment, including resources available in the application for getting more out of NONLIN.

The User’s Guide uses the following notations and conventions:

*Italics* represent error or cautionary messages.

**Bold Courier** represents the input expected of the user.

Text in *Ariel* font represents a menu command.

Function keys and other special keys are enclosed in brackets. For example, `[↑]`, `[↓]`, `[←]` and `[→]` are the arrow keys on the keyboard. `[F1]`, `[F2]`, etc., are function keys; `[BkSp]` is the Backspace key for backspacing over characters; `[Del]` is the Delete key for deleting characters to the right; `[Ins]` is the Insert key for inserting characters to the left of the insertion point.

The symbol `[↵]` and `[Enter]` refer to the same key.
Welcome to NONLIN

What is NONLIN?

NONLIN\(^1\) is a Microsoft Windows\(^2\) based application for the dynamic analysis of single degree of freedom structural systems. The structure may be modeled as elastic, elastic-plastic, or as a yielding system with an arbitrary level of secondary stiffness. The secondary stiffness may be positive, to represent a strain hardening system, or negative, to model P-Delta effects. The dynamic loading may be input as an earthquake accelerogram acting at the base of the structure, or as a linear combination of sine, square, or triangular waves applied at the roof of the structure. The program uses a step-by-step method to solve the incrementally nonlinear equations of motion. See Clough and Penzien [1] for a theoretical description of the solution technique.

While NONLIN may be used for professional practice or academic research, the fundamental purpose of the program is to provide a visual basis for learning the principles of earthquake engineering, particularly as related to the concepts of structural dynamics, damping, ductility, and energy dissipation.

Program Design and Concepts

All input for NONLIN is carried out interactively through the use of the computer keyboard and the mouse. For the current version, plots are written to the screen in several different “windows” and tabular output information can be written to four different output file types that can be saved to disk. These files include a text file with the .OUT extension which summarizes the latest run and three tab-delimited files with the .XL1, .XL2 and .XL3 file extensions. These tabular data files are intended for use with a spreadsheet program such as Microsoft Excel. This allows you to perform further processing of the data or to graph the output data for inclusion in reports and other documents. The .Xlx files can be viewed or printed from a simple text processing program such as Microsoft WordPad. Graphical screen plots of several different types are produced during program execution. Hard copies of any of the screen plot windows may be obtained as described later in this manual.

After the structural properties and loading have been input, you may obtain the following information:

<table>
<thead>
<tr>
<th>Loading Type</th>
<th>Input Time History</th>
<th>Fourier Amplitude Spectrum</th>
<th>Response Spectrum</th>
<th>Computed Time Histories</th>
<th>Computed Hysteresis Plots</th>
<th>Computed Energy Time Histories</th>
<th>Result Summaries</th>
<th>Animate Structure Response</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wave Form</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Earthquake</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Free Vibration</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>


\(^2\) Windows is a trademark of Microsoft Corporation, Redmond, Washington.
System Requirements

NONLIN must be run on a 80486 or better PC compatible system using either Windows 95 or Windows NT V4.0. The system should have a minimum hardware configuration appropriate to the operating system you are using.

For best results, your system’s video should be set to 800 by 600 resolution, displaying not less than 256 simultaneous colors. However, resolutions as low as 640 by 480 and as high as 1024 by 768 will work. The computer must be equipped with a Microsoft compatible mouse, trackball, or other pointing device.

Installing NONLIN Using the SETUP Utility

To install NONLIN, run the SETUP utility provided on disk one of the program disks set. The installation procedure is given below will work for both Windows NT V4.0 and Windows 95.

1. Insert disk one in the appropriate drive, A: or B:.
2. From the Start Menu on the Taskbar, choose Run.
3. Type a:setup (or b:setup).
   Or:
   From the Start Menu, choose Settings.
3. Double click on the Add/Remove Programs icon. Follow the instructions of the Wizard to select the setup program for NONLIN.
4. Follow the setup instructions on the screen. NONLIN and associated compressed files are expanded and placed in the newly created \Program Files\Nonlin directory by default. You can change the directory name if you choose during the setup process.
5. You can run NONLIN from the Start button on the Taskbar, highlighting Programs, and then clicking on the NONLIN icon,
   Or:
   You can drag the NONLIN program icon to your desktop. A Shortcut icon is created in the dragging process. To run NONLIN, double click the shortcut icon.

If you choose to browse the newly created \NONLIN directory, you will notice that there are several files that possess an .ACC file name extension. These are earthquake acceleration records that are supplied with the program. of this help file lists the acceleration records as well as pertinent facts about the records. The records supplied with your disk may be different from those listed in Appendix A. The acceleration records are written in a special format, as described in.

The SETUP utility also places several files in your \WINDOWS\SYSTEM directory. These files MUST be present for NONLIN to run. These files include:

   COMDLG32.OCX
   THREED20.OCX
RICHTX32.OCX
VSVIEW20.OCX

Do not delete or move these files. If any or all of these files are accidentally deleted from the \WINDOWS\SYSTEM directory, you will have to run SETUP again to replace them.

Also included on the distributions disks is a copy of the manual for NONLIN (NONLIN.DOC). This file is a Word for Windows document. To view or print this file you must have Word for Windows Version 7.0 or newer.
Part One

NONLIN SDOF Systems - Program Data Input
Description of the User Interface

After NONLIN is started, the NONLIN Version 7.05: filename window (hereafter referred to as the “NONLIN” window) and the STRUCTURE PROPERTIES INPUT window automatically appear. The filename is “untitled” when you first start the program and becomes the problem file name when a problem is created or loaded from disk. These windows are shown in Figure 1.

The NONLIN window consists of a title bar, a menu bar, and a button bar. The NONLIN window is always open, and serves as a “container” for all other windows used by the program. Closing the NONLIN window terminates the program, and minimizing the window reduces the entire NONLIN environment to an icon. The title bar displays the active problem file name to the right of the colon.

Figure 1. The NONLIN and STRUCTURE PROPERTIES INPUT windows.
The Menu Items

The menu bar as shown in Figure 1 has menu items **File**, **Parameters**, **Quik Quake**, **Quik Wave**, **Window**, **View**, and **Help**. These menus items are available whenever the **STRUCTURE PROPERTIES INPUT** window is the active window. The underlined character indicates that the menu may be opened by holding down the Alt key in combination with the underlined letter. For example, the **File** menu may be opened by pressing Alt-F. Any menu item may also be opened by clicking the item with the mouse. Some of the menu items in the **NONLIN** window menu bar will change depending upon which one of several other windows is currently the active.

The **File** menu displays the following submenus when the **STRUCTURE PROPERTIES INPUT** window is open:

You can save individual problems in separate files. You create problem files which contain all necessary input data to run a **NONLIN** analysis. All problem files have the .NLN file name extension. The first four submenus allow the creation, storage and retrieval of problem files. In addition, the file names of past problem runs will appear below the **Exit** submenu as shown above. This is typical of many Windows applications. Clicking the problem file name will load the problem. Clicking on **Exit** immediately terminates the program.

If a secondary input or output window, such as those which display screen plots of acceleration, velocity and so on, is open, the **File** menu changes to display one of various sub-menus, depending upon which secondary window is open. For example, when you have opened the **Computed Time Histories** or the **Computed Hysteresis** windows to view the structural response, the **File** menu takes the following form:
Print Plots produces a printer plot of the open window, which usually contains one or more plots. The Create File option, if clicked, causes an output file to be created which is stored in the NONLIN directory. The output file is always called NONLIN.XL1 when the Summary of Computed Results window is open. Anytime the NONLIN.XL1 file is created, it overwrites any existing file of the same name. This file is a tab-delimited file for use with a spreadsheet program. One use for this file and any other .Xlx file is to obtain a smooth plot of the output data for inclusion in a report using the plotting features of Microsoft Excel.

When the Summary of Computed Results window (described later) is open, the File menu takes this form:

The two print options either print all result pages or the current result page, depending upon which option you choose. The Create File option is the same as described above.

The Create File option is also active when the Computed Energy Plots window is open. If you choose to create a file in this case, the NONLIN.XL2 file contains values of strain + kinetic, damping, hysteretic and total energy. Anytime the NONLIN.XL2 file is created, it overwrites any existing file of the same name. This file is a tab-delimited file for use with a spreadsheet program.

When the EARTHQUAKE RESPONSE SPECTRUM OF INPUT window is active the following file menu is displayed:
If you choose to create a file in this case, the program writes spectral displacement, velocity, and acceleration to the file NONLIN.XL3. Anytime the NONLIN.XL3 file is created, it overwrites any existing file of the same name. This is also a tab-delimited file for use with a spreadsheet program. You can also print the current plot, and if the current plot is Tripartite, you can print a blank plot.

Anytime that you create a .XL1, .XL2 or .XL3 file, you can view the contents of the file in a window on the screen by positioning the cursor inside the active window and clicking the right mouse button. The tab-delimited file appears in a separate window.

When the FFT window is open, the following file menu is active. From here you have the option of printing the total FFT plot (only).

As described earlier, clicking on Exit in any form of the File menu immediately terminates the program after asking if you are sure that you want to exit and asking if you want to save the current problem in a file for future use.

The Parameters menu is only displayed when the STRUCTURE PROPERTIES INPUT window is open. It contains four submenus as shown here:

The Step Factor X submenu asks for the digitization step factor X which is used in controlling program accuracy. Reducing X will increase solution speed, but may reduce accuracy. It is recommended that X not be set to a value less than 50. The Color Printing menu option toggle the color printing of plots on and off. If you do not have a color printer, this menu item is ignored. The Input Mass As submenu asks you if you want to enter the mass of the structure as a mass in mass units (e.g., k-sec^2/in), a mass in weight (e.g., lbs), or as a period. If you enter the mass of the structure as a weight, the program converts the weight to mass units, and if you input the period, the mass will be calculated (in mass units) using the assigned stiffness value K1. The Input Damping As submenu asks for the damping either as a constant (e.g., k-sec/in) or as a percent of critical value. Damping values are explained in more detail in the Entering Structural Properties section.
The Quik Quake menu is only displayed when the STRUCTURE PROPERTIES INPUT window is open. Quik Quake is a shortcut method of bringing earthquake data into NONLIN for use in a simulation. Clicking Quik Quake displays a list of the earthquake ground acceleration record file names supplied with the program. Clicking one of the acceleration file names immediately loads the appropriate acceleration record to be applied to the structure. The name of the earthquake record is displayed at the bottom of the STRUCTURE PROPERTIES INPUT window. Choosing an earthquake acceleration automatically changes the dynamic force to be applied as a ground acceleration for analysis by the program. The Quik Quake option will appear in gray if no acceleration records (i.e., the .ACC files) are present in the NONLIN directory.

A more powerful method of defining earthquake accelerations is built into NONLIN. You can obtain time history, FFT and response spectrum plots as well as modify the accelerations of a particular record. These features are available through the use of the Earthquake Ground Acceleration Input window. Its features are described in a later section.
The Quik Wave menu is only displayed when the **STRUCTURE PROPERTIES INPUT** window is open. From here you can select a previously saved wave, or by selecting New Wave you can display a separate window that allows you to define the forcing function wave. The New Wave window is show below.

You can select one of three different wave types, sine, square and sawtooth by clicking on the appropriate button. Then, within this window, you can define the **Total Time** of the time history plot, the **Digitization Interval** (DT), the **Amplitude**, the **Period** and the **Duration** that the forcing function wave is applied to the structure. Defining a forcing function wave automatically changes the dynamic force to be applied as a forcing function for analysis by the program.

The Quik Wave provides a quick way to define a wave forcing function. A **WAVE GENERATOR** window is available to you under the **Forcing Function** option in the **Dynamic Force Applied as...** window. This window gives you many options for creating your own wave forcing function and saving it for future use. This option is described in more detail later in this manual.
The **Window** menu contains the sub-menu items **Cascade**, **Tile**, and **Arrange Icons**. These items indicate how the active windows or icons will be displayed. The **Window** menu will also list the names of all windows that are currently open, with a check mark to the left of the window that is currently active. To access a non-active window (including one that has been minimized) click on the name of the window in the window list.

The **View** menu has a single item, which when clicked which will display (or remove) a small panel showing a brief summary of the latest analysis results. This small panel is located between the columns of the structure, under the mass icon. Figure 1 shows the structure window with the results panel activated. Note that the **View** menu is available only when the **STRUCTURE PROPERTIES INPUT** Window is active.

The **Help** menu contains only contains four submenu topics. Selecting **Contents** from the **Help** menu displays an alphabetical list of the contents of this help file. You can also search for a specific help topic by selecting **Search**. **How to use Help** displays the standard Windows Help on Help text for users unfamiliar with the Windows help system. The last item in this menu is **About NONLIN**. Click on this menu item to contain basic information about the program.
The Button Bar

The button bar contains seven buttons, each of which is briefly described below:

Structure Restore Button

Press this button to restore the STRUCTURE PROPERTIES INPUT window if it has been closed. In most cases, you will keep this window open at all times.

NO GO/GO Analysis Buttons

When NONLIN is first loaded, the NO GO button shown at the left will appear with a red square in the center. This indicates that not all of the required data has been input. If the button is pressed before the data is completely entered, the program will provide a window that lists the portions of data that are missing.

Once all of the data has been correctly entered, the red NO GO button will change to a green triangle, the GO button, indicating that the program is ready to perform an analysis run. Once the button has been pressed, the analysis will proceed, and results will be available for viewing.

The green GO button also appears when you have loaded a problem file with the Open Problem... option in the File menu or highlighting a problem name in the lower potion of the File menu.

To the right of the GO/NO GO button is the RUN frame which displays the number of the latest analysis run executed by NONLIN.

View Computed Time Histories Button

After the analysis has been run, you may click the Time History button to display the computed time-histories of displacement, spring force, and yield event codes, with additional plot types available as explained later. This button is inactive when the Start Analysis button contains a red square. If the structure data, units, or loading has changed since the last run, NONLIN will request that the Start Analysis button be clicked before reviewing plots.

When the time history window is the active window, selecting the menu options File and then Print Form will send a copy of the plots to a printer.
**View Computed Hysteresis Plots Button**

After the analysis has been run, you must click this button to display the computed hysteresis curves. Three hysteresis curves are displayed: inertial force versus displacement, damping force versus displacement, and spring force versus displacement, with additional plot types available as explained later. If the structure data, units, or loading has changed since the last run, NONLIN will request that the green GO button be clicked before reviewing plots.

When the hysteresis plot window is the active window, selecting the menu options **File** and then **Print Form** will send a copy of the plots to a printer.

**View Computed Energy Plots Button**

Press this button to display the relative or absolute dissipated energy time history plot. This plot shows how the earthquake input energy is dissipated through structural kinetic, recoverable strain, damping, and hysteretic energy. By moving the mouse laterally while the plot is displayed, the relative percent of structural energy for each structural energy type is displayed. For a reference on computing energy time-histories, see Uang and Bertero [2].

If the structure data, units, or loading has changed since the last run, NONLIN will request that the green GO button be clicked before reviewing plots.

When the energy window is the active window, pressing the menu options **File** and then **Print Form** will send a copy of the plots to a printer.

**Review Summary of Computed Results Button**

Press this button to obtain a summary of computed results. The window displayed shows the current contents of the NONLIN.OUT output file. When the summary window is the active window, you can obtain a hardcopy of the output file contents. An example of the Summary of Computed Results Window is shown in Part Two of this manual.

**Animate Button**

Press this button to view an animated representation of the structure displacing from side to side. This represents the response of the structure to the ground acceleration or forcing function wave.
**Response Spectrum Plot Button**

Pressing this button opens the EARTHQUAKE RESPONSE SPECTRUM OF INPUT window. You do not need to load an earthquake file first, however, you will only have access to Code Spectra plots if you do not. You can open an earthquake either through the Quick Quake menu or via the EARTHQUAKE GROUND ACCELERATION INPUT window.

**Displacement Ductility Spectra Plot Button**

Pressing this button opens the DISPLACEMENT DUCTILITY SPECTRA plot window. This form can be activated through this button only after the user has entered the structural properties. The seismic resistance coefficient versus time period plots are generated for eight pre-defined ductility factors. The desired period range, additional variables, and the ductility factors can be changed through input provisions provided on the form.
Entering Structural Properties

The structural properties are entered through the STRUCTURE PROPERTIES INPUT window, which is shown in Figure 1. This window contains seven parts or frames:

- The Unit Type input frame
- The Length Units input frame
- The Force Units input frame
- The Dynamic Force Applied as... input frame
- The Constitutive Properties input frame (which includes the structure diagram)
- The Dynamic Properties output frame
- The Summary of Latest Run output frame

The Unit Type, Length Units and Force Units Frames

These three frames are input frames - you are expected to click on the appropriate buttons within these frames. NONLIN can operate in either U.S. Customary or metric units. Unit types are toggled by the two option buttons in the Unit Type frame. For U.S. Customary units, lengths may be entered in the Length Units frame as inches or feet and forces may be entered in the Force Units frame in pounds or kips. When metric units are selected, lengths are centimeters or meters and forces are either Newtons or kilo-Newtons. You may switch from one unit type to another at any time. Data that has already been entered is automatically converted as soon as you select the appropriate units.

When the applied dynamic force is an earthquake ground acceleration, NONLIN automatically converts the acceleration units into units which are expressed as a fraction of the acceleration due to gravity. The acceleration of gravity in the current computational units is always shown on the Gravity line (the last line) of the Dynamic Properties frame. Note that these units automatically change when the computational units are altered via the option buttons in the Unit Type, Length Units and Force Units frames.

If a wave type forcing function is used, the forcing function amplitude is assumed to be in units of force consistent with the unit types selected using the Unit Type, Length Units and Force Units frames.

The Constitutive Properties Frame

This frame includes both the Constitutive Properties frame and the structure diagram. Six general items of input corresponding to five large icon buttons and one small button, are expected in order to analyze your problem.

The structure is idealized as a single degree of freedom system, as shown schematically in Figure 1. For linear analysis, the following properties are required:
> MASS
> DAMPING
> INITIAL STIFFNESS $K_1$

For nonlinear analysis two additional properties are required:

> SECONDARY STIFFNESS $K_2$
> YIELD STRENGTH $F_y$

Structural properties are entered by clicking the three structure stiffness buttons located within the Constitutive Properties frame and the mass and damping buttons located above and below the structure mass in the structure diagram. Data input is described for each button as follows:

**Structural Mass/Weight/Period Button**

This button either represents a mass with an “M” in the icon, a weight with a “W” in the icon, or a sine wave. NONLIN changes the icon to match the Input Mass As choice that you made in the Parameters menu. To enter structural mass or weight, press the MASS/WEIGHT icon. An input window will open to prompt for the appropriate data. The structural mass or weight must be greater than zero.

If you choose mass units, the weight of the structure is displayed in the next to last line of the Dynamic Properties frame. If you choose weight units, the mass is displayed on this line. Masses are derived from weights by dividing the weight by the acceleration due to gravity. NONLIN converts the units internally once the mass or weight has been input.

Example: If a structure has a weight of 55 kips, NONLIN will internally calculate the mass by dividing by $32.2 \text{ ft/sec}^2$ times 12 inches per foot as follows:

$$\text{mass} = \frac{55.0}{386.1} = 0.142 \text{ kip-sec}^2/\text{inch}$$

Sometimes it is useful to enter a structure with a known period. This option allows this to be done by entering the period on the MASS box. When the STIFFNESS is entered, this is used together with the period to compute a corresponding mass value.

**Structural Damping Button**

To enter structural damping, press the DAMPER icon. Damping can be input either as a percent of critical or as a damping constant. The Damper icon will display a small % or a “c” to indicate which case is active. Critical damping is defined as the smallest amount of damping required to prevent an oscillatory motion (no zero displacement crossings) after a system is given an initial displacement and then released. Critical damping is mathematically defined as follows:
\[ c_r = 2m \omega \]

where \( m \) is the system mass (in mass units), and \( \omega \) is the structural circular frequency in radians/second, computed as

\[ \omega = \sqrt{\frac{K_1}{m}} \]

and \( K_1 \) is the initial stiffness of the system, as described in the following section.

In NONLIN, a non-dimensional damping value \( \xi \) is entered as

\[ \xi = \frac{100 c}{c_c} \]

The 100 in the above equation converts the damping into a percent. NONLIN will allow damping values from 0 to 100 percent critical. However, damping values of 2 to 7 percent critical are commonly used for analysis of structures responding to earthquake ground motions, where it is anticipated that the response will go into the nonlinear (inelastic range). Note that lower values of damping may be appropriate for computation of the response of systems which are intended to remain elastic. High damping values (20 to 30% critical) may be used to represent structures with added viscous damping.

Example: Assume a structure has an initial stiffness of 70 kips/inch, and a weight of 55 kips. The mass of the structure is \( \frac{55}{386.1} = 0.142 \text{ kip-sec}^2/\text{inch} \). The circular frequency \( \omega = \sqrt{\frac{70}{0.142}} = 22.2 \text{ radians/sec} \). If a damping of 5 percent critical is desired, enter 5.0 at the prompt. The damping coefficient \( c \) used in the analysis is \( \frac{5.0}{100} c_c = 0.05(2)(0.142)(22.2) = 0.315 \text{ kip-seconds/inch} \).

As previously mentioned, the damping constant may be entered directly.

**Structural Stiffness \( K_0 \) Button**

To enter the initial structural stiffness, press the STRUCTURAL STIFFNESS icon. The initial stiffness \( K_0 \) is illustrated below. \( K_0 \) has units of force/length. For nonlinear analysis, the unloading stiffness is assumed to be equal to the initial stiffness.
After both the mass and the initial stiffness have been entered, NONLIN will compute and display the structure’s dynamic properties, which include the circular frequency $\omega$ (radians/second), the cyclic frequency $f$ (Hertz), and the period of vibration $T$ (seconds).

**Structural Strain Hardening Stiffness $K_2$ Button**

The secondary stiffness is the first of two properties required for nonlinear analysis. To enter the secondary stiffness, press the SECONDARY STIFFNESS icon and respond to the prompt. The secondary stiffness is the slope of the post-yielding portion of the force-displacement response of a structure. The value may be positive, representing strain hardening, or zero, representing an elastic-perfectly plastic response. The secondary stiffness $K_2$ is illustrated below. *Note that $K_2$ must be less than the initial stiffness of the structure and must be greater than or equal to zero.*

![Strain Hardening Stiffness Diagram](image)

**P-Delta Stiffness $K_G$ Button**

The P-Delta stiffness $K_G$ needs to be supplied if the user chooses to include P-Delta effects in the analysis. The choice to include the P-Delta effect in the analysis is made by checking/unchecking the checkbox named INCLUDE P-DELTA. To input the P-Delta stiffness, press the P-DELTA STIFFNESS icon and respond to the prompt. Even though this stiffness is entered as a positive quantity, it is converted to a negative value in the display as an indication of the P-Delta effect.

Based on the P-Delta stiffness value supplied by the user, the program automatically adjusts the initial stiffness and the yield strength to include such effects. This is accomplished as explained below.

Assume a structure without P-Delta effects considered has an initial stiffness $K_o$, a yield strength $F_{y,o}$, and a strain hardening stiffness of zero. (Yield strength is described in the following section.) The structure is shown in the figure on the next page.
Under gravity force $P$ (compression positive), the structure has an initial stiffness $K_I = K_o + K_G$, where $K_G$, the P-Delta stiffness, is computed as follows:

$$K_G = -\frac{P}{h}$$

For this structure, the effective initial stiffness is calculated as $K_I = K_o + P/h$. If the yield strength of the structure without P-Delta effects is $F_{y,o}$, the effective yield strength $F_y$, is calculated by the program as follows:

$$F_y = F_{y,o}(1 - \frac{P}{K_o h})$$

Example: Assume a structure in absence of a vertical force $P$ has an initial stiffness of 50 kips/inch, and after yielding at a lateral force of 20 kips, has a strain hardening stiffness of zero. If the column height $h$ is 10.0 feet, and the total vertical force $P$ is 480 kips, determine the initial stiffness, the secondary stiffness, and the yield strength to be used for a nonlinear P-Delta analysis.

P-Delta stiffness $K_G = -\frac{P}{h} = -480/(10 \times 12) = -4.0$ kips/inch

Effective initial stiffness $K_o + K_G = 50 + (-4) = 46$ kips/inch

Effective yield Strength $= F_y = F_{y,o}(1 - \frac{P}{K_o h})$

$$= 20(1 - 480/(50 \times 23 \times 10)) = 18.4 \text{ k/in}$$
**Yield Strength $F_y$ Button**

The system yield strength is the second of two properties required for nonlinear analysis. To enter the yield strength, press the YIELD STRENGTH icon and respond to the prompt. The yield strength, which is illustrated below, is given in force units.

![Force vs. Displacement Graph]

**Linear/Nonlinear Analysis Options**

Just below the Yield Strength button are two small buttons (also called radio buttons) which you can use to define whether you want a linear or nonlinear analysis of the defined structure. If you choose a linear analysis, the secondary stiffness and yield strength buttons are disabled because they do not apply to a linear analysis. The frame for this selection is shown below.

![Constitutive Properties Table]
Dynamic Properties Output Frame

This frame is located in the lower right corner of the STRUCTURE PROPERTIES INPUT window. The frame echoes the structure properties input values. Except for the Gravity line, the frame will contain no values until the structure properties have been defined either by defining a new problem or loading a problem file.

<table>
<thead>
<tr>
<th>Dynamic Properties</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Period, seconds</td>
<td>0.392</td>
</tr>
<tr>
<td>Frequency, Hertz</td>
<td>2.553</td>
</tr>
<tr>
<td>Frequency, R/sec</td>
<td>16.044</td>
</tr>
<tr>
<td>Effective K1, k/in</td>
<td>30.000</td>
</tr>
<tr>
<td>Effective Fy, k</td>
<td>44.118</td>
</tr>
<tr>
<td>Damping</td>
<td>0.199 k-sec/ft</td>
</tr>
<tr>
<td>Mass</td>
<td>0.117 k-sec/ft</td>
</tr>
<tr>
<td>Gravity</td>
<td>346.1 in/sec/ft</td>
</tr>
</tbody>
</table>

Summary of Latest Run Output Frame

This frame is located inside the structure diagram in the STRUCTURE PROPERTIES INPUT window. It provides several items of output data that are updated after every run. The frame contains no values until an analysis run has been executed.
Dynamic Force Applied as... Input Frame

As previously mentioned, the forcing function may be either a prerecorded earthquake, a linear combination of up to five sine, square, or triangular waves, or a free vibration. As shown in Figure 1, the type of dynamic force is toggled by clicking on the appropriate option button in the Dynamic Force Applied as... input frame.

![Dynamic Force Applied As...](image)

Defining a Ground Acceleration

You can bring an earthquake acceleration record into NONLIN through the Quik Quake menu option or you can use the more sophisticated Ground Acceleration input function. When the Ground Acceleration button is activated, the icon in the Dynamic Force Applied as... input frame resembles an accelerogram. Clicking on this icon, shown below, opens a special frame for inputting and plotting data associated with the selected ground motion.

![Accelerogram Icon](image)

Upon pressing the accelerogram icon, the EARTHQUAKE GROUND ACCELERATION INPUT frame appear as illustrated in Figure 2 ahead.

In Figure 2, the STRUCTURE PROPERTIES INPUT window has been minimized so that only the NONLIN window and the EARTHQUAKE GROUND ACCELERATION INPUT windows frames are visible.

To select a pre-recorded earthquake, click the File Open icon which resides in the upper left of the window. The icon looks like this:

![File Open Icon](image)

All of the pre-recorded earthquake files have a name in the format FILENAME.ACC, where FILENAME is a one to eight character name, and ACC is the default extension for the accelerograms. When installing NONLIN, several acceleration files were copied to the NONLIN directory of the hard disk. In Figure 2, the file which has been opened is NRIDGE1.ACC.
For NONLIN to be able to read an acceleration record, it must be in a special format. This format is described in detail in Appendix B of this documentation.

After the file has been opened, NONLIN displays a description of the record, and shows the pertinent aspects of the record, including the number of points in the record, the digitization interval, the duration, and minima and maxima of acceleration, displacement, and velocity, if present in the record. NONLIN also shows the units at which the record was loaded. As mentioned earlier, the record will be non-dimensionalized by dividing by the appropriate acceleration of gravity before being sent to the computational unit of NONLIN.

![Figure 2](image)

Figure 2 The **EARTHQUAKE GROUND ACCELERATION INPUT** window

The acceleration record may be used as-is, or may be revised by changing the maximum acceleration, reducing the number of points to be included in the NONLIN analysis, or changing the discretization interval. In Figure 2, these quantities have been changed to 400 mm/sec, 2000 points, and 0.01 seconds, respectively. The revised values will be used by NONLIN unless the **RESET to Original** button is clicked prior to clicking the **USE for ANALYSIS** button. When
the USE for ANALYSIS button is clicked, the EARTHQUAKE GROUND ACCELERATION INPUT window is minimized, and NONLIN will be ready to run (if all structural properties have been previously entered).

Before describing the plotting options, it is very important to note that changing the digitization interval of a record does not rediscretize the accelerogram. The effect is to compress or expand the time scale, as shown below.

It should be noted that the velocity and displacement time histories are also affected by a change in the discretization timestep.

There are two circumstances where you may want to change the digitization interval. The first is to change the frequency content of the earthquake ground. The second reason to change the accelerogram is for dimensional similitude as required in model studies. For a true scale model with a dimensional scale factor of $n$ ($n = 5$ for a 1/5 scale model), the time digitization interval should be divided by the square root of the scale factor.
Displaying Ground Acceleration Plots

Using the plotting options, you may plot the ground acceleration, velocity, and displacement, develop an elastic response spectrum, or plot a Fourier amplitude spectrum. The plots are obtained by clicking one of the three buttons in the lower right hand corner of the EARTHQUAKE GROUND ACCELERATION INPUT window. Note that either the original or the revised data may be plotted. Recall however, that if the ground motion characteristics have been revised, the revised motion will be used by NONLIN unless the Reset To Original button has been clicked.

The acceleration, velocity, and displacement plots are self explanatory, and will not be described further. It should be noted, however, that hard copies of the plot may be obtained by clicking the File menu, and then clicking the Print Form menu item. The form in which ground acceleration, velocity, and displacement are displayed is shown in Figure 3.
Generating and Displaying Response Spectrum Plots

By selecting the Response Spectra box, response spectra will be plotted for up to six different damping values. The damping values are selected from the Damping Values frame that appears after you have pressed the PLOT DATA button. After pressing the button, the input frame on the left side the Earthquake Response Spectrum of Input window as shown in Figure 4 appears.

![Earthquake Response Spectrum of Input Window](image)

Figure 4 Earthquake Response Spectrum of Input Window.

The five damping values shown, plus one additional value may be used. The response spectrum is plotted on a logarithmic plot, with either 10, 20, 40, 80, 160, or 320 equally spaced points being plotted per logarithmic decade (points per decade). Click the appropriate check boxes and radio buttons, and then click the COMPUTE SPECTRUM button shown below.

![Example of COMPUTE SPECTRUM button](image)

Pressing the COMPUTE SPECTRUM button computes the spectrum for the selected damping values. The spectrum is plotted versus structural period, or structural frequency, at your option. The plot type is by default Tripartite, as shown in the center of Figure 3. On this logarithmic plot type, logarithmic axes for displacement and acceleration are superimposed at an angle to the orthogonal period and velocity axes. This is a common method of presenting the spectrum.
While the spectrum is being computed, a progress bar is displayed for each damping value selected. The spectra are computed by a piecewise exact integration scheme per Chopra.[3].

After the spectrum has been computed, the **Compute Spectrum** button changes to the **Plot Spectrum** button. You can change plot types and display the corresponding plot. The spectrum does not have to be recomputed as long as you do not change the damping values. If you do change the damping values, you must re-compute the spectrum.

You will notice that if you drag the cursor through the Tripartite plot, the Spectral Coordinates in the frame at the top of the window change to indicate the values at the cursor location.

If you choose the **Create File** menu option at this point, the NONLIN.XL3 file is written to disk. This is a tab-delimited file that can be manipulated with a spreadsheet program. Any of these types of Response Spectrum plots may be printed by selecting the **Print Plot** option from the **File** menu. Note that you also have the option of printing a blank tripartite plot.

By choosing the Separate Plot Type option, the program displays three plots: displacement versus period, pseudo velocity versus period and pseudo acceleration versus period. The Separate Plots may be Log-Log, Log-Arithmetic or Arithmetic-Arithmetic. Example Separate Plots are shown in Figure 5.

![Figure 5 - Separate Plots of Sample Spectrum](image-url)
As with the Tripartite plot, the Spectral Coordinates in the frame at the top of the window change to indicate the values at the cursor location if you drag the cursor through any of the plots.

**Generating and Displaying Demand Spectrum Plots**

The third type of plot available from this screen is the Demand Spectrum plot. A demand spectrum is an elastic response spectrum plotted with the spectral displacement on the horizontal axis, and the pseudoacceleration on the vertical axis. Radial lines represent the square of the circular frequency, but for convenience are labeled as period values. The structure’s force-deformation response (capacity spectrum) may be superimposed on the demand spectrum to provide useful design information. Demand-Capacity spectra are a major feature of the ATC-33 Recommendations for Rehabilitation of Existing Buildings. An example of this type of plot is shown in Figure 6.

![Figure 6 Example Demand Spectrum Plot](image)

Any of these types of Response Spectrum plots may be printed by selecting the Print Plot option from the File menu. Note that you also have the option of printing a blank tripartite plot.

You can toggle between acceleration in g units and in acceleration units by pressing the Acceleration toggle in the upper right hand corner of the plot.
Code Spectra Plots

Through the Code Spectra Menu on the Response Spectrum window, you have access to seven different types of Code spectra plots, 1994 and 1997 UBC, 1991, 1994, and 1997 NEHRP, FEMA 273, and the Newmark-Hall method. Select the code that you wish to examine from this menu, and a parameters box for this code will be displayed. Set the parameters that fit your analysis and press OK. Below is an example of the parameters for the Newmark-Hall type of spectra.

To see the plot press the compute code spectrum button shown below.

After your chosen code spectra is computed, you have all of the same plots available as you did with the Earthquake response spectrum. These include tripartite, separate and capacity demand.
Some of the code spectra plots, particularly UBC, can be seen well by only displaying the first 5 seconds of the plot. This is available by checking the appropriate box in the lower left corner of the window.

![Figure 7 Newmark-Hall Spectra](image)

If you have computed both a code spectra and an earthquake response spectrum you have the option of overlaying the two curves in the same plot. Again, you have the option of viewing a tripartite plot, separate plots, or a capacity demand plot.

**Generating and Displaying Fourier Amplitude Spectrum Plots**

As mentioned previously, a Fourier amplitude spectrum (FAS) can also be generated and printed. In NONLIN, the transform is normalized to have a maximum value of 1.0. The frequency that has a Transform ordinate of 1.0 is the dominant frequency in the ground motion. The plot is useful in viewing the energy content of a forcing function wave or earthquake at different frequencies. For example, the majority of the energy of the Imperial Valley Earthquake as measured at El Centro in May 1940 was focused between 1 and 2.25 Hertz.

A Fourier transform (often referred to as FFT, which is technically incorrect because the FFT is a method, whereas the transform itself is a result) converts a time function into a frequency...
function. A Fast Fourier Transform (FFT) is a preferred numerical method to compute the Fourier transform. An FFT requires that the number of time-amplitude data points passed to the routine be a power of 2. This is automatically taken care of in NONLIN.

Different segments of an earthquake may have different frequency content. The Traveling FFT provides a method for determining the frequency content of segments of the ground motion (or computed response) consisting of 128, 256, or 512 contiguous points in the motion. An example of this screen is show in Figure 8.

Figure 8 Fourier Amplitude Spectrum and Traveling FFT Window

Dragging the cursor through the total FFT plot shown in the FOURIER AMPLITUDE SPECTRUM OF INPUT window changes the values of frequency and amplitude shown in separate boxes. You can also obtain a printed output of the total FFT plot using the Print Plot option in the File menu.

Fine tuning of the upper and lower frequencies of the display is possible by entering values in either or both of the text boxes in the middle left side of the form. To do this, uncheck the box
named AUTOMATIC and then supply the upper bound and lower bound for the frequency range to display. Similarly, you can specify the amplitude range to display.

Different segments of an earthquake may have different frequency content. The Traveling FFT provides a method for determining the frequency content of segments of the ground motion (or computed response) consisting of 128, 256, or 512 contiguous points in the motion. The FAS of the entire response is shown in the large plot at the upper right of the FAS window, and to the left of this is a small plot showing the entire time-history (see Figure 8). This time-history has a small traveling window, whose position is controlled from the VCR type controls on the button bar at the right of the window. Across the bottom of the form are three smaller FAS plots representing three intervals of wither 128, 256, or 512 contiguous points from the original record. You select the number of points to use from the “# of Points” frame on the window. Note that the center plot on the bottom of the window represents the time range shown in the moving window. The plots to the left (previous) and right (next) represent the windows to the left and right of the traveling (current) window. Note that the three adjacent windows overlap as shown in the figure below. The smaller the number of points used in the traveling FAS window, the coarser the resolution in the plot.

The FFT algorithm used by NONLIN requires that the number of points passed to the routine be a power of two. For the original time-history, a portion of zero amplitude response is appended to the record to provide the required number of points. For example, if the input/output record contains 1200 points, the number of points sent to the FFT routine would be 2048, 1200 points of data and 848 points of zero amplitude data.

The frequency range (maximum recoverable frequency) in a FAS plot is given by:

\[ f_{\text{range}} = \frac{0.5}{\Delta t} f_{\text{range}} = (0.5/dt) \]

where \( \Delta t \) is the digitization time step of the original record. The maximum recoverable frequency \( f_{\text{range}} \) is also known as the Nyquist frequency. This is equal to one half of the sampling frequency. For example, to fully recover a sine wave with a frequency of 1.0 Hz, you...
must measure at twice this frequency, or 2.0 Hz. The FFT routine provides amplitudes at \( n/2 \) discrete frequencies within this range, where \( n \) is the number of points passed to the FFT routine.

**Defining a Wave Forcing Function**

When Forcing Function is activated, the icon in the **Dynamic Force Applied as...** frame resembles a complex waveform. Clicking on this icon, shown below, opens a special window for inputting and plotting a forcing function which consists of a linear combination of simple sine, square, or triangular waves.

The **WAVE GENERATOR** window is shown in Figure 9.

![Wave Generator Window](image)

**Figure 9** The **WAVE GENERATOR** Window

The **WAVE GENERATOR** window consists of six frames plus four buttons.
After you have defined a wave form, you can save it via the Wave form menu as show below. You can also load an existing wave form, rename the current wave form, or start a new one.

In the **Signal Length and Digitization Frame**, you enter the total wave duration and the discretization interval. The number of time steps is then automatically computed and displayed.

To create a signal, move to the **Frequency Data Frame**, and select the wave type for each component of a one to five part wave. Individual wave components may be sine, square, or triangular in type. At least one wave must be active at all times.

For each wave activated, the Period, the Amplitude, the Phase Lag, and the Duration of each wave component must be specified. The duration of any or all waves may be set to a value less than the total length of the signal. The phase lag shifts the entire wave to the right by an amount equal to the time entered. The phase lag must be set to a value less than the period for the particular wave. If all waves are shorter in duration than the total wave length, the structure will enter into free vibration once all the signals have terminated.

In the **Startup Ramp Frame**, you may enter a value between 2 and 100 to gradually increase (from zero) the magnitude of the wave form over the initial portion of the total time period selected. For example, a 10 second signal with a startup ramp of 20% will cause a gradually increasing wave over the first two seconds of the function. The last eight seconds of the signal will not be affected by the ramp.

In the **Random Noise Frame**, you may superimpose a random noise on the combined wave form. The maximum magnitude of the random noise may be from 0 to 50 percent of the maximum wave amplitude (without noise).

The **Signal Description** input frame is used to enter a title for the wave form. This title will appear on all plots produced by the program.

The **Point of Application** frame is used to specify the degree-of-freedom to which the signal is to be applied.

You also have the option of applying the forcing function as a ground motion. When this box is checked, the forcing function is treated as a ground motion during the calculations (only). The amplitude is then taken as an acceleration represented as a fraction of gravity. This is useful to
when trying to model specific ground motion characteristics that are not present in the earthquake files supplied with NONLIN.

**Displaying Wave Generator Plots**

After all wave parameters have been set, click on the Generate Signal to create the waveform. When the wave is ready, the Time-History Plot and the FFT Plot buttons become active, and when clicked, cause the program to display the corresponding plot. The Time-History plot shows the force amplitude versus time. If the Plot Total Wave Only box is checked, the intermediate waves will not be plotted. The FFT (Fast Fourier Transform) plot transforms the wave from the time domain to the frequency domain so that the normalized energy content of the wave versus frequency can be seen.

To obtain a hard copy of a plot, click the File menu, followed by the Print Form menu.

When you are ready to use the waveform in response computation, press the USE for ANALYSIS button, at which time the WAVE GENERATOR window will automatically minimize. If all structural data has been previously input, you are now ready to proceed with an analysis of the structure. Part Two of this manual describes the execution of the program to obtain analysis results.

**Free Vibration**

The free vibration option imposes an initial unit displacement on the structure, and then releases the structure. NONLIN assumes that all free vibration problems are linear. The resulting free vibration trace may be used to verify the program’s accuracy by comparing the computed period and damping value with the theoretical values. The damping computed by NONLIN may be obtained from the rate of decay (logarithmic decrement) of the free vibration trace.

When Free Vibration is activated, the icon in the DYNAMIC FORCE APPLIED AS... frame resembles a free vibration wave. Clicking on this icon, shown below, opens a window for adjusting some of the starting properties.

Here you can set the starting displacement and velocities, as well as adjust the length of the signal. If you do not enter any properties in this box, the program will select appropriate ones for you.
### Free Vibration

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Starting Displacement, in</td>
<td>1</td>
</tr>
<tr>
<td>Starting Velocity, in/sec</td>
<td>0</td>
</tr>
<tr>
<td>Maximum Duration, sec:</td>
<td>3</td>
</tr>
</tbody>
</table>

*(If zero, calculated internally)*
Part Two

NONLIN SDOF Systems - Program Result Output
Program Execution Results

NONLIN’s primary function is to model the response of a single degree of freedom structural system to a dynamic loading. To this point, this manual has described the process of providing input data to NONLIN in order to run the program to obtain numerical and graphical output describing the response. A brief summary of typical input actions follows:

- Define the units
- Define the properties of the model structure
- Define the forcing function by choosing an earthquake or defining a wave forcing function
- Define the type of analysis desired, that is, linear or nonlinear or
- Open a problem file in which input information has been saved and make modifications, if necessary

This section of the manual addresses the actual running of the program to produce the output results.

Running the Analysis

Running the analysis of the model structure to obtain the dynamic response is very simple. After you have entered all data necessary input data, the red NO GO button gives way to the green GO button. The presence of the GO button gives you an indication that necessary and sufficient input data has been entered.

To produce an analysis run, simply click the GO button.

A progress bar will appear at the bottom of the STRUCTURE PROPERTIES INPUT window to indicate that the run is progressing. The speed of progression depends largely on the speed of your computer, the length of the record and step factor. When the analysis is complete, a run number indicator in the NONLIN window increments, e.g., RUN0 is replaced with RUN1 and so on. The Summary of Latest Run frame in the STRUCTURE PROPERTIES INPUT window is updated. You are now ready to view, save and/or print the computed time histories plots, the computed hysteresis plots, the computed energy plots and/or the summary of computed results. You can also view an animated representation of structural displacement.
Click on:

- to view the **COMPUTED TIME HISTORIES** plots.
- to view the **COMPUTED HYSTERESIS PLOTS**.
- to view the **COMPUTED ENERGY PLOTS**.
- to view the **SUMMARY OF COMPUTED RESULTS**.
- to view an **ANIMATION** of the structural response.

Each of these output features is described in more detail in the following sections.
Computed Time Histories

Perhaps the first item of interest after running the analysis is to view the **COMPUTED TIME HISTORIES** plots. You can open this window by clicking the appropriate button as described above. The window always displays three plots which default to displacement, velocity and yield code versus time. Example time histories plots are presented in Figure 10.

![Computed Time Histories Window](image)

Figure 10 Example **COMPUTED TIME HISTORIES** Window

You can change any of the plots to one of nine different time histories by clicking the buttons above each plot. If you change one or more of the time histories, the plots will be automatically updated with the new information.

Both the **COMPUTED TIME HISTORIES** window and the **COMPUTED HYSTERESIS PLOTS** window have one icon button in the upper left corner of the their respective windows. This button performs the same function in either window, as follows:
The RESIZE button expands the plots to the limits of the graph so that maximum values are readily apparent. If you click on the RESIZE button again, the vertical and horizontal axes unit values change back to convenient values beyond the maxima.

Both the **COMPUTED TIME HISTORIES** window and the **COMPUTED HYSTERESIS PLOTS** window possess an additional feature. When either of these two windows is the active window, the menu bar in the NONLIN window presents an **Options** menu item. A Plot Points submenu is presented when the **Options** menu item is clicked. You can choose to have every point, every second point, every fourth point, every sixth point or every eight point plotted. Your choice here does not effect the screen plotting of the time histories or the hysteresis plots. The feature is added to NONLIN to allow for a smaller plot file to be transferred to your printer in the event that your printer cannot handle the amount of data sent with a “plot every point” plot. You may have to experiment to find the largest number of points (i.e., the highest resolution) that your printer can handle.

The **COMPUTED TIME HISTORIES** plots possess a helpful feature. If you drag the cursor across any of the three plots, the cursor becomes a double headed arrow with a vertical line through the middle. You will notice that changing data values are given above each plot that corresponds to the position of the cursor.

You can obtain a hardcopy of the plots by clicking the File menu and choosing **Print Form**. If you choose the Create File menu option, the NONLIN.XL1 tab-delimited file is written to disk. Uses for this file are the same as the other .Xlx files already described.

Additionally, for all time history results except Yield Codes you can view the time history calculated as a Fourier Transform in the FFT window by clicking the FFT button to the right of each plot.
Computed Hysteresis Plots

Generally, the next output view of interest are the **COMPUTED HYSTERESIS PLOTS**. The plots are useful to view various forces in the system versus displacement, acceleration or velocity. Clicking the appropriate button opens the window which always displays three plots. The plots show inertial force, damping force and spring force versus displacement by default. An example of the hysteresis plots are presented in Figure 11.

![COMPUTED HYSTERESIS PLOTS](image)

Figure 11 Example of **COMPUTED HYSTERESIS PLOTS**.

You can change the ordinates to one of five different force types and the abscissas to displacement, acceleration or velocity by clicking the down-arrow boxes above and below each plot. If you change any of the values, the plots will automatically be updated.

The **COMPUTED HYSTERESIS PLOTS** window contains the RESIZE button. The function of this button is identical to the function described in the **COMPUTED TIME HISTORIES** section above.

You can obtain a hardcopy of the plots by clicking the File menu and choosing Print Form.
Computed Energy Plots

This plot shows the total energy dissipated over the time span of the earthquake or forcing function event. The energy contributions of the kinetic+strain, damping and hysteretic energies as well as the total energy are shown. An example of the energy plot is shown in Figure 12.

![Computed Energy Plots Window](image)

Figure 12 Example **Computed Energy Plots** Window

The dark vertical line in the example plot indicates the position of the cursor. Note that the percentages of the energy types change as you drag the cursor through the plot. The vertical blue lines in the hysteretic energy are the yield events. If the analysis is based on an earthquake and is nonlinear, you can view either the relative (default) or the absolute energies. The energy time histories allow for the input energy to be computed on the basis of relative velocities or total absolute velocities. This affects the magnitude of computed kinetic energy, as well as the magnitude of total energy. It has been shown in a paper by Uang and Bertero ["Evaluation of Seismic Energy in Structures", Earthquake Engineering and Structural Dynamics, pp 77-90, Vol. 19, No. 1, 1990] that for structural period ranges of about 0.3 to 4.0 seconds, relative and absolute energy maxima are almost identical. Significant differences can occur for very low or very high period structures. These differences can be very important when computing energy spectra and using these spectra for design.
The thin blue line at the top of the plot is the total energy calculated separately. If the blue line does not closely follow the top the cumulative energy curve, set the Step value in the Parameters menu to a higher value. Note that this total energy line does not show up on the printed output of the energy plot.

Note that if the analysis is based on a user defined wave for the forcing function (even if that forcing function is being treated as a ground motion), or a linear analysis is being used, you will only be able to view the relative energy.

You can obtain a hardcopy of the plot or create the .XL2 file by clicking the File menu and choosing Print Plot or Create File, respectively.

It is worth noting that the hysteretic energy is an indication of structural damage resulting from the application of the dynamic loading. The higher the percentage contribution of the hysteretic energy to the total energy, the greater the damage to the structure.
Summary of Computed Results

The **Summary of Computed Results** window is provided to give you a summary of numerical results from your analysis runs. Clicking the appropriate button as described above opens the window. The problem filename, analysis type (linear or nonlinear), structural properties, forcing function properties and a summary of response maxima are presented.

The window shows the current contents of the `filename.OUT` output file. When the window is opened, the file is positioned to the last run executed. Use the scroll bar at the right of the window to view the results of earlier runs. The scroll bar moves in discrete jumps from run summary to run summary, not in a continuously smooth, scrolling manner.

When the summary window is the active window, clicking the **File** menu and then **Print All Pages** or **Print Current Page** will send the appropriate portions of the `.OUT` file to the printer.
As previously mentioned, the Create File menu option writes the NONLIN.XL1 file to disk when this window is active.

**Animation**

A unique feature of the program is the **Animation Window**. When opened by clicking the animation button, a representation of the model structure and five plots are produced and displayed in time increments. You can control the display progress and speed through the use of a recorder control in the upper left corner of the window. The recorder control looks like this:

![Recorder Control](image)

You can stop, start, reverse, fast reverse, fast forward the progress of the simulated response. You can also reverse to start and forward to end. A separate Animation Speed slider is provided to control the speed of the simulation. A Time Value slider is also provided so that you can move to any point in time in the duration of the simulation. The Time Value slider moves to indicate the relative point in time in the progressing simulation.

By default, the structure roof displaces but the structure foundation remains fixed. Note that the Relative Displacement radio button is set. By choosing the Total Displacement radio button, you can change the display to simulate ground motion as well as structure motion. Clicking on the Undeformed Shape check box in the upper right corner of the window produces a stationary reference shadow representing the original position of the structure before the application of the dynamic loading.

Three time history plots of Input Ground Acceleration, Displacement and Yield Code versus time are constantly updated and displayed in the center portion of the window. To right of the time histories plots, you see two hysteretic plots: Damping and Spring force versus displacement.
A yellow line appearing at the top or bottom of the two structure columns indicates yielding of the structure.

A printed of the animation window is not directly available. However, if you press Print Screen on your computer keyboard, the current screen image is saved to the Windows Clipboard. If you close or minimize NONLIN and open a drawing program such as Paint, you can Paste the image to the drawing program workspace by using the Edit menu. From this point, you can modify the image, print it or save to a file.

Figure 14 Example ANIMATION Window.
Part Three

NONLIN MDOF Systems- Advanced Modeling Capabilities


Introduction

Version 7.05 of NONLIN has new capabilities that allow you to model more complicated structures, with more complex hysteretic properties. The basic model is a three degree of freedom system, with the capability to analyze base isolated structures and structures incorporating passive energy devices. P-Delta effects are included directly as a structural parameter. The new hysteretic models allow simple bilinear behavior, complex multilinear behavior including strength degradation, stiffness degradation, and pinching. An advanced smooth hysteretic model with strength and stiffness degradation and pinching is also included.

The new capabilities are provided in a special module of NONLIN referred to herein as MDOF-NONLIN. The material presented in this section of the NONLIN documentation refers almost exclusively to MDOF-NONLIN.

Theoretical Description

Structural Idealization

NONLIN analyzes the three degree of freedom system pictured in Figure 15.

![Figure 15](image)

In this structure, the frame, device, and isolator may have nonlinear force-deformation relationships, and the brace is always assumed to be linear. In addition, the device and the

---

3 Source code for the multilinear and smooth hysteretic models was provided by A.M. Reinhorn and M.V. Sivaselvan of the Multidisciplinary Center for Earthquake Engineering Research (MCEER), State University of New York, Buffalo, New York. The models are completely described in the report “Hysteretic Models for Cyclic Behavior of Deteriorating Inelastic Structures”. The MCEER Technical Report Number (to be published in 1999) was unassigned at this writing.
isolator may have linear or nonlinear viscous damping. The elastic/inelastic spring and damping components of the device and the isolator are assumed to act in parallel. P-Delta effects may be included in the solution if desired.

The inelastic behavior of the frame, device, and isolator may be described by three different models; simple bilinear, multilinear, and smooth. A linear elastic model is also available. The simple bilinear model provides strength degradation. The multilinear and smooth models allow for degradation of stiffness and strength, with or without pinching. The assumed hysteretic behavior of these elements is described in detail later.

The base structure may be configured into a variety of types:

- Simple rigid frame
- Braced frame
- Braced frame with device
- Base-isolated frame
- Base-isolated braced frame
- Base-isolated braced frame with device

While certain of the models may appear to be one or two degree of freedom systems, MDOF-NONLIN treats each internally as a three degree of freedom structure. For example, when the base isolator is “removed” from the system, its stiffness is set to a large value, and its mass and damping are set to very low values. When the device is removed, but the Chevron brace remains, the device stiffness is set to a large value, and its mass and damping are set to very low values. When the brace is to be eliminated, the device stiffness is set to a very low value. Table 1 summarizes the modelling procedures.

### Table 1  MDOF-NONLIN Element Properties

<table>
<thead>
<tr>
<th>Model</th>
<th>Frame</th>
<th>Brace</th>
<th>Device</th>
<th>Isolator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Simple Frame</td>
<td>User Defined</td>
<td>k = 10E10</td>
<td>k = 10E-10</td>
<td>k = 10E10</td>
</tr>
<tr>
<td></td>
<td></td>
<td>m = 10E-10</td>
<td>m = 10E-9</td>
<td>m = 10E-9</td>
</tr>
<tr>
<td></td>
<td></td>
<td>c = 0.0</td>
<td>c = 0.0</td>
<td>c = 0.0</td>
</tr>
<tr>
<td>Braced Frame</td>
<td>User Defined</td>
<td>User Defined</td>
<td>k = 10E10</td>
<td>k = 10E10</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>m = 10E-9</td>
<td>m = 10E-9</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>c = 0.0</td>
<td>c = 0.0</td>
</tr>
<tr>
<td>Braced Frame with Device</td>
<td>User Defined</td>
<td>User Defined</td>
<td>User Defined</td>
<td>User Defined</td>
</tr>
<tr>
<td>Base Isolated Frame</td>
<td>User Defined</td>
<td>k = 10E10</td>
<td>k = 10E-10</td>
<td>User Defined</td>
</tr>
<tr>
<td></td>
<td></td>
<td>m = 10E-10</td>
<td>m = 10E-9</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>c = 0.0</td>
<td>c = 0.0</td>
<td></td>
</tr>
<tr>
<td>Base Isolated Braced Frame</td>
<td>User Defined</td>
<td>User Defined</td>
<td>k = 10E10</td>
<td>User Defined</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>m = 10E-9</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>c = 0.0</td>
<td></td>
</tr>
<tr>
<td>Base Isolated Braced Frame</td>
<td>User Defined</td>
<td>User Defined</td>
<td>User Defined</td>
<td>User Defined</td>
</tr>
<tr>
<td>with Device</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The (tangent) stiffness matrix for the structure consists of five parts:

\[ K = K_F + K_B + K_D + K_I + K_G \]

where the subscripts refer to Frame, Brace, Device, Isolator, and Geometric stiffness components, respectively.

Because mass and damping are not assigned to the brace, the mass and damping matrices for the structure consist of only three parts each:

\[ M = M_F + M_D + M_I \]

\[ C = C_F + C_D + C_I \]

The components of the stiffness matrix are as follows:

\[
K_F = \begin{bmatrix}
k_F & 0 & -k_F \\
0 & 0 & 0 \\
-k_F & 0 & k_F
\end{bmatrix}
\]

\[
K_B = \begin{bmatrix}
0 & 0 & 0 \\
0 & k_B & -k_B \\
0 & -k_B & k_B
\end{bmatrix}
\]

\[
K_D = \begin{bmatrix}
k_D & -k_D & 0 \\
-k_D & k_D & 0 \\
0 & 0 & 0
\end{bmatrix}
\]

\[
K_I = \begin{bmatrix}
0 & 0 & 0
\end{bmatrix}
\]

and

\[
K_G = \begin{bmatrix}
-W_F/h_F & 0 & W_F/h_F \\
0 & 0 & 0 \\
-W_F/h_F & 0 & -(W_F + W_I)/h_I
\end{bmatrix}
\]

In the above, \( k_F, k_B, k_D, \) and \( k_I \) are the incremental tangent stiffnesses of the frame, brace, device, and isolator components. \( W_F \) is the weight of the frame, \( W_I \) is the weight of the isolator (including first floor slab), \( h_F \) is the height of the frame above the isolator, and \( h_I \) is the height of the isolator level. Note that the geometric stiffness matrix does not include the weight of the device nor the weight of the brace. Both of these are assumed to be small in comparison with the weight of the frame and the weight of the isolator (actually the weight of the floor slab at the isolator level). P-Delta effects remain constant throughout the analysis.

The mass is assumed to be lumped, producing a diagonal mass matrix:

\[
M = \begin{bmatrix}
m_F & 0 & 0 \\
0 & m_D & 0 \\
0 & 0 & m_I
\end{bmatrix}
\]

The damping components of the damping matrix are as follows:
\[
C_F = \begin{bmatrix} c_F & 0 & 0 \\ 0 & 0 & 0 \\ 0 & 0 & 0 \end{bmatrix} \quad C_D = \begin{bmatrix} c_D & -c_D & 0 \\ -c_D & c_D & 0 \\ 0 & 0 & 0 \end{bmatrix} \quad C_I = \begin{bmatrix} 0 & 0 & 0 \\ 0 & 0 & 0 \\ 0 & 0 & c_I \end{bmatrix}
\]

Note that the frame’s contribution to damping is assumed to be mass proportional. Stiffness proportional frame damping would be

\[
C_F = \begin{bmatrix} c_F & 0 & -c_F \\ 0 & 0 & 0 \\ -c_F & 0 & c_F \end{bmatrix}
\]

When the isolator is disabled, the same results would be obtained regardless of the form of frame damping chosen. When the isolator is active, the two different damping assumptions could give slightly different results. However, the frame damping when used in association with a device or an isolator will be very small (less than 5% critical), so the differences in computed results would be negligible.

**Hysteretic Modeling**

For each of the structural components (except for the brace which is always linear elastic), you may select from four different force-deformation relationships:

1) LINEAR elastic 
2) BILINEAR with strain hardening or strain softening 
3) MULTILINEAR with stiffness degradation, strength degradation, and pinching 
4) SMOOTH hysteresis with stiffness degradation, strength degradation, and pinching

There are no restrictions as to how the models may be used in a structure. For example, a bilinear model may be used for the frame, with a smooth model for the device, and a multilinear model for the isolator.

The linear model is straightforward, with member force always being proportional to deformation. The backbone curve of the force-deformation relationship for the bilinear model is shown in Figure 16 ahead.
In this model, the positive and negative yield values may be different, as well as the positive and negative strain hardening slopes. The strain hardening slopes may be greater or less than zero, but should not exceed the initial slope. The model loads and unloads along the initial slope. If different positive and negative strain hardening slopes are used, the model will produce unreasonable results at deformations beyond the point where the strain-hardening lines cross.

The multilinear model is rule based, and can represent quite complex behavior. There are three sub-types for this model:

1) Simple bilinear
2) Trilinear with Bauschinger effect and pinching
3) Vertex oriented

The backbone curve for the simple bilinear multilinear model is identical to that shown in Figure 2, with the exception that the multilinear model does not allow strain hardening slopes less than zero. For simplicity, the user should use the bilinear model in lieu of the multilinear model if only simple bilinear behavior is desired.

For this version of MDOF-NONLIN, the trilinear multilinear model has been forced to behave in a bilinear fashion, but advanced behavior including degradation and pinching is allowed. The backbone curve is identical to that shown in Figure 16. Four additional parameters may be used to control the response, as shown in Table 2.
Table 2 Parameters for MULTILINEAR model

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Purpose</th>
<th>Value for Minimal Effect</th>
<th>Value for Extreme Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALPHA</td>
<td>Stiffness Degradation</td>
<td>100</td>
<td>5</td>
</tr>
<tr>
<td>BETA1</td>
<td>Strength Degradation(Ductility Based)</td>
<td>0.01</td>
<td>1.0</td>
</tr>
<tr>
<td>BETA2</td>
<td>Strength Degradation(Energy Based)</td>
<td>0.01</td>
<td>1.0</td>
</tr>
<tr>
<td>GAMMA</td>
<td>Pinching</td>
<td>1.0</td>
<td>0.2</td>
</tr>
</tbody>
</table>

In addition to the above values, the user must also enter the maximum positive and negative deformations. If the computed deformations exceed these values the element is assumed to “break”, losing all strength and stiffness. In MDOF-NONLIN, these deformations are entered as maximum positive and negative ductility limits. It is recommended that these ductility values be kept in the range of 10 to 15.

To obtain simple bilinear behavior, set ALPHA=100, BETA1=0.01, BETA2=0.01, and GAMMA=1.0. As explained later, MDOF-NONLIN provides tools for testing the effects of the various parameters prior to analysis. In lieu of describing these effects here, the user is encouraged to experiment with the parameters.

The smooth model provides smooth transition into yielding, rather than abrupt transitions as in the multilinear model. This allows for more realistic modeling of certain types of structural components, such as shear links in eccentrically braced frames, and yielding metallic “fuses” in ADAS type passive energy systems.

The smooth model uses the same backbone parameters as shown in Figure 16, except that a strain hardening stiffness less than zero is not allowed, and the positive and negative strain hardening slopes must be equal.

The parameters used to control the smooth model are described in Table 3. As with the multilinear model, it is recommended that the user experiment with the smooth model parameters before using them in an analysis.
## Table 3 Parameters for SMOOTH model

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Purpose</th>
<th>Value for Minimal Effect</th>
<th>Value for Extreme Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>ALPHA</td>
<td>Stiffness Degradation</td>
<td>100</td>
<td>5</td>
</tr>
<tr>
<td>BETA1</td>
<td>Strength Degradation (Ductility Based)</td>
<td>0.01</td>
<td>1.0</td>
</tr>
<tr>
<td>BETA2</td>
<td>Strength Degradation (Energy Based)</td>
<td>0.01</td>
<td>1.0</td>
</tr>
<tr>
<td>GAMMA</td>
<td>Not Used</td>
<td>N.A.</td>
<td>N.A.</td>
</tr>
<tr>
<td>NTRANS</td>
<td>Yielding Transition smoothness (smooth transition)</td>
<td>1.0</td>
<td>10.0</td>
</tr>
<tr>
<td>ETA</td>
<td>Unloading slope/shape (parallel to initial slope)</td>
<td>0.5</td>
<td></td>
</tr>
<tr>
<td>NGAP</td>
<td>Gap Closing Exponent</td>
<td>1.0</td>
<td>4.0</td>
</tr>
<tr>
<td>PHIGAP</td>
<td>Gap Closing Curvature</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>RS</td>
<td>Pinching Parameter</td>
<td>0.0</td>
<td>0.40</td>
</tr>
<tr>
<td>LAMBDA</td>
<td>Pinching Parameter</td>
<td>0.0</td>
<td>0.50</td>
</tr>
<tr>
<td>SIGMA</td>
<td>Pinching Parameter</td>
<td>0.05</td>
<td>0.4 (set to 1.0 for no slip)</td>
</tr>
<tr>
<td>KAPPA</td>
<td>Gap Closing Spring Multiplier</td>
<td>2.0</td>
<td>5.0</td>
</tr>
</tbody>
</table>

## Damping

As mentioned earlier, the viscous damping behavior for the device or the isolator may be either linear or nonlinear. The damping behavior is described as follows:

\[ F_D = C \|\dot{v}\|^{exp} \text{sign} (\dot{v}) \]

Where \( F_D \) is the force in the device, \( C \) is a damping coefficient, \( \dot{v} \) is the deformational velocity across the device, and \( exp \) is an exponent, typically between 0.4 and 2.0. For \( exp = 1.0 \) the device behaves as a linear viscous dashpot. For low values of \( exp \) the device is “force limited”, meaning that at high velocities the device produce an almost constant force. For \( exp \) of 2, the device is often known as a kinetic energy damper, and will efficiently dissipate energy due to sudden impact. In earthquake engineering applications, \( exp \) is typically between 0.4 and 1.0. Because MDOF-NONLIN does not iterate on equilibrium unbalances, it is recommended that a very small time step be used when analyzing structures with nonlinear damping devices.

The damping in the frame is strictly linear. For analysis of structures incorporating passive energy devices or highly damped base isolators it is recommended that the damping in the frame be set to no more than one or two percent critical. There is no damping contribution from the chevron brace.
Loading

The structure may be subjected to load histories or ground accelerations. Load histories, when used, may be applied to any active degree of freedom, including the base of the structure. Earthquake ground motions are always applied at the base of the structure. As described later, MDOF-NONLIN provides two similar sets of utilities for loading the structure.

Solution

The dynamic equilibrium equations are solved incrementally in the time domain using the Newmark constant average acceleration technique. The user may control the solution time step by dividing the loading time step into a number of sub-increments. Warning: The MDOF-NONLIN program does not iterate on equilibrium error. It is up to the user to verify the accuracy of the results by reanalyzing with various sub-step assumptions until the solution converges. Regardless of the time step used, MDOF-NONLIN saves results at the digitization interval of the loading function.
Using MDOF-NONLIN

Accessing the MDOF-NONLIN Model

The new modeling capabilities are accessed by clicking **Model** on the main menu bar, and selecting **MDOF Model** from the drop down list:

![Figure 17 Accessing MDOF-NONLIN Capabilities](image)

After selecting the MDOF model, the familiar NONLIN model is replaced by the 3-DOF model, as shown in the following figure:

![Figure 18 The MDOF-NONLIN Main WINDOW](image)
The MDOF-NONLIN window shown in Figure 4 contains five parts:

A Menu bar
A Tool Bar
The Frame Type Selection Box (the left most panel)
The Structure Box
A Load Selection Box (lower left panel)

As may be seen, the Structure Box portrays a picture of the structure similar to that shown in Figure 1.

The Menu Bar

The menu bar has 7 items:

File
Parameters
Units
Model
Quik Quake
Quik Wave
Window
Help

Save model or open previously saved model
Toggle on/off P-Delta Effects
Set Units
Toggle between SDOF and MDOF models
Quickly load earthquake
Quickly load forcing function
Window Manipulation
NONLIN Help System

With the exception of Parameters and Units, these menu items are self-explanatory. (Please refer to the NONLIN manual for information on the use of Quik Quake and Quik Wave.)

The Parameters item is used toggle on or off P-Delta effects. When turned on, a P-Delta input box appears in the lower left hand of the MDOF-NONLIN window (below the load selection panel). When the P-Delta button is clicked, a data entry form is opened, where you are required to enter the height of the frame columns, and if the isolator is activated, the height of the base isolator. Also enter the gravity multiplier if you want P-Delta effects to be based on gravity forces larger than obtained those from the mass alone. The P-Delta entry form is shown in Figure 19. After the correct values have been entered, click SET to save the value to memory, and USE to close the box. Click CANCEL to close the box without making a change.

P-Delta effects are based on the weight of the frame and the weight of the isolator only. Because masses are typically used for these quantities, NONLIN will convert to weight by using the acceleration of gravity constant that is set by opening Units on the menu bar.
The structure may become unstable due to P-Delta effects. This is particularly true when the isolator is used. To prevent this type of instability, the stiffness of the isolator must be as follows:

\[ k_i > \frac{G (m_F + m_I)}{h_I} \]

Where \( m_F \) and \( m_I \) are the masses of the frame and isolator, \( h_I \) is the height of the isolator, and \( G \) is the acceleration of gravity. If this condition is not satisfied, MDOF-NONLIN will issue an error message prior to computing dynamic properties or prior to performing an analysis.

**Units**

MDOF-NONLIN requires you to use consistent units throughout the analysis. You can not automatically switch units as you can in the NONLIN SDOF model. Clicking on Units on the main menu opens the Units box, shown in Figure 20. In the current version of the program, only U.S. customary units may be specified. The length and force units you choose are used only to label the plots produced by the program. The acceleration of gravity is used in converting weight to mass (or mass to weight) when required by the program. It is also used in setting true acceleration units (length/sec\(^2\)) when earthquake time-histories are used as loading. This will be explained in more detail in the Loads section of this documentation. MDOF-NONLIN automatically enters the acceleration units when you switch from inches to feet. NONLIN will automatically open the units box if you attempt to perform an operation requiring the acceleration of gravity units with out first setting the units.
The Tool Bar

The NONLIN Toolbar contains eight buttons

1) Restore the main structure screen after it has been closed
2) Set analysis parameters and compute response
3) Display Structure Property Matrices
4) Compute and Display Dynamic Properties (Frequencies, Damping values, etc.)
5) Plot time-history results
6) Plot hysteretic results
7) Show summary table

Note that one or more of these buttons will be inactive if all the required data has not been entered, or if an analysis has not been completed.
Structure Type Panel

The structure type panel allows you to select the type of model to be analyzed. Either click the picture of the structure, or click the adjacent option button to select the structure type. After the type is selected, the picture will be shown with a red border, and the frame picture will change to reflect the selection. Figure 21 below shows the Braced Frame with Device as being selected, and to the right, the re-drawn structure is shown. Note that the isolator and first floor slab has been removed from the structure.

![Structure Type Panel](image)

![Resulting Model](image)

Figure 21  Structure Type Panel and Resulting Model

The properties of the frame are entered after clicking the FRAME… button. The small box to the right of the FRAME… button shows a question mark "?". After the frame properties have been properly entered, the question mark changes to an exclamation point "!" to indicate that the data has been set.

Entering Structural Properties

The frame properties panel shown in Figure 22 is available after clicking the FRAME… button. This box is divided into sub-panels, each designed to enter a specific portion of the data.

At the top of the main panel, a sub-panel is provided for mass entry. This mass may be entered in mass units (force-sec²/length), or in weight (force) units if the appropriate box is checked.
The Hysteresis panel is used to set the hysteretic model type, and to enter the backbone curve properties shown in Figure 16. If the model is symmetric (same positive and negative values), data entry is simplified by checking the Symmetric box. If the model type is Linear, the data entry boxes for all inelastic properties are disabled.

![Frame Properties Box](image)

Figure 22 The Frame Properties Box
For the Bilinear model only, negative values may be entered for secondary stiffness K2 and K3. Otherwise, all other values should be entered as positive. The sign for the negative yield strength is set internally within NONLIN.

If the Multilinear model is selected, the panels labeled "Common Parameters for Multilinear and Smooth Model", and "Multilinear Model" are activated. It is here that the controlling variables listed in Table 2 are provided. Where available, slider bars may be used to change the properties. Sliders positioned to the left create standard hysteretic shapes. Sliders moved to the right increase the degrading stiffness, degrading strength, and pinching effects.

For the Smooth model, the "Smooth Model" panel is activated, and the "Multilinear" panel is disabled. Enter the desired smooth model parameters in the boxes provided. Recall that a description of the properties was given in Table 3. For the Smooth model and the Multilinear model, NONLIN will not let you enter invalid controlling values in the boxes.

For the Frame property only, damping is entered as percent critical. The damping coefficient $c_F$ is then computed on the basis of the mass and frame stiffness provided. For this computation, the frame is considered to be fixed at its base.

Once all the data has been entered, it is recommended that the hysteretic properties be tested. This is particularly true for the Multilinear and Smooth models. To test the properties, first set the data by clicking the SET button, and then press TEST. After clicking TEST, the Frame panel expands as shown in Figure 23.

![Figure 23 Frame Properties Panel with Test Panels Visible](image_url)
Two new panels are provided. The Loading Function panel allows you to create a deformation history to subject the model to. This history consists of a number of sine pulses of increasing amplitude. A pulse is one full sine wave. Each pulse is divided into a number of steps. A pulse with a period of 1 second, if divided into 100 steps, would have a digitization interval of 1/100 or 0.01 seconds. A segment of loading may have more than one pulse, and the total load history consists of a number of segments. The total number of points (steps) in the generated wave is

\[ N = \text{segments} \times \text{pulses/segment} \times \text{steps/pulse} \]

The amplitude of the initial pulse is defined, and the amplitude of subsequent pulses depends on the segment increment value. If the segment increment is less than 1.0, the amplitude of the segments (not the individual pulses) increases arithmetically. The amplitude of all pulses in segment \( n \) will be:

\[ A_n = A_0 + (n-1)A_0S \]

In the above, \( A_0 \) is the initial amplitude, and \( S \) is the segment increment.

For example, if the initial amplitude is 2.0, the segment increment is 0.2, and there are 5 segments, the segment amplitudes would be:

<table>
<thead>
<tr>
<th>Segment</th>
<th>Amplitude</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2.0</td>
</tr>
<tr>
<td>2</td>
<td>2.4</td>
</tr>
<tr>
<td>3</td>
<td>2.8</td>
</tr>
<tr>
<td>4</td>
<td>3.2</td>
</tr>
<tr>
<td>5</td>
<td>3.6</td>
</tr>
</tbody>
</table>

If the segment increment is greater than 1, subsequent pulses grow geometrically according to the following relation:

\[ A_n = A_0S^{n-1} \]

If the initial amplitude is 2.0, and the segment increment is 1.2, the segment amplitudes would be:

<table>
<thead>
<tr>
<th>Segment</th>
<th>Amplitude</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2.000</td>
</tr>
<tr>
<td>2</td>
<td>2.400</td>
</tr>
<tr>
<td>3</td>
<td>2.880</td>
</tr>
<tr>
<td>4</td>
<td>3.456</td>
</tr>
<tr>
<td>5</td>
<td>4.147</td>
</tr>
</tbody>
</table>

If the ultimate deformation box is checked, the initial pulse amplitude is automatically computed to give a final deformation equal to the yield deformation times the ductility limit. This forces the element to be exercised through its entire range.
Once the load parameters are set, click CREATE LOAD, and then PERFORM TEST to exercise the element. A typical result is shown in Figure 24.

If the hysteretic properties as tested are not as desired, simply change the modelling parameters and re-test. Once you are satisfied with the model, click SET to save the parameters, and then USE to close the form. If you would like to simply exit without making any changes, click CANCEL. If you choose CANCEL, all the data written to the properties panel will be lost, and the data that was originally set (perhaps by default) is restored.

![Frame Form with Test Performed on Multilinear Model](image)

Figure 24  Frame Form with Test Performed on Multilinear Model

Entering properties for the Device (or Isolator) is done in a similar fashion. The properties panel is identical to that of the Frame, except for the damping properties. Because the damping may be nonlinear, a damping constant $C$ and a velocity exponent $exp$ is required. The test panel allows
you to test the properties of the damper, by plotting damper force vs displacement or damper force vs velocity. An example of the device properties input panel with the damper tested vs displacement is shown in Figure 25.

![Figure 25 Device Properties Panel with Test Performed on Nonlinear Damper](image)

Figure 25 Device Properties Panel with Test Performed on Nonlinear Damper
The properties for the brace are much simpler to enter because the brace is linear elastic. The Brace properties panel is shown in Figure 26. Because the properties are linear, no testing procedure is necessary. Note that the brace stiffness to be entered is the horizontal stiffness of the chevron brace, not the stiffness of the individual brace elements.

![Figure 26 Brace Properties Panel](image)
Reviewing Properties Prior to Analysis

After all the structural properties have been set, you may proceed with the definition of loading, and then analysis. Before doing so, it is advisable to review the properties that have been set, and to compute the dynamic properties of the structure. MDOF-NONLIN provides several tools for the review of the data. These tools are provided through buttons 2, 3, and 8 on the toolbar.

The Display Matrices Button, button 2, displays the initial stiffness matrix, the geometric stiffness matrix (for P-Delta effects), the total stiffness matrix, the mass matrix, and the damping matrix. An example of the Matrices Window is shown in Figure 27.

![Figure 27 The Matrices Window](image)
Dynamic Properties

MDOF-NONLIN computes both the damped and undamped dynamic properties of the model. These values are obtained by clicking the Dynamic Properties button on the toolbar. The dynamic properties include frequencies, mode shapes, and damping values for each of the three modes of response. The three-mode dynamic values are provided regardless of the type of model chosen.

Undamped modes and frequencies are computed by standard procedures. These values are then used to estimate the equivalent viscous damping in each mode. Damping values are computed using the modal strain energy approach.

Because the damping matrix for the MDOF-NONLIN model is typically non-proportional, a complex eigenvalue solver is used to obtain the damped frequencies, and damping values. In most cases, the damped and undamped dynamic properties should be similar. In some highly nonproportional cases, the damped quantities can be significantly different from the undamped quantities. An example of the dynamic properties results are shown in Figure 28.

![Figure 28 The Dynamic Properties Results Window](image-url)
Summary Tables

At any point in the development of the model, a summary table may be displayed which shows the state of the model, loading, and results. The summary table is accessed by clicking the Summary Table button on the toolbar. Summary table information may be printed at any time. An example of the summary table is shown in Figure 29. This table represents the properties in a model using only bilinear properties, but without loading or results.

![Figure 29 The Summary Table](image)

Summary of Structural Properties as Input

<table>
<thead>
<tr>
<th>STRUCTURE TYPE:</th>
<th>3</th>
</tr>
</thead>
<tbody>
<tr>
<td>FRAME PROPERTIES:</td>
<td>1</td>
</tr>
<tr>
<td>Mass</td>
<td>M = 5</td>
</tr>
<tr>
<td>Damping Constant</td>
<td>C = 2.5</td>
</tr>
<tr>
<td>Initial Stiffness</td>
<td>K1 = 125</td>
</tr>
<tr>
<td>Secondary Stiffness</td>
<td>K2 = 10</td>
</tr>
<tr>
<td>Secondary Stiffness</td>
<td>K3 = 10</td>
</tr>
<tr>
<td>Positive Yield Strength</td>
<td>FYP = 250</td>
</tr>
<tr>
<td>Negative Yield Strength</td>
<td>FYN = -250</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>DEVICE PROPERTIES:</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mass</td>
<td>M = 1</td>
</tr>
<tr>
<td>Damping Constant</td>
<td>C = 20</td>
</tr>
<tr>
<td>Initial Stiffness</td>
<td>K1 = 10</td>
</tr>
<tr>
<td>Secondary Stiffness</td>
<td>K2 = 1</td>
</tr>
<tr>
<td>Secondary Stiffness</td>
<td>K3 = 1</td>
</tr>
<tr>
<td>Positive Yield Strength</td>
<td>FYP = 1000</td>
</tr>
<tr>
<td>Negative Yield Strength</td>
<td>FYN = -1000</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>ISOLATOR PROPERTIES:</th>
<th>1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mass</td>
<td>M = 0.0000000001</td>
</tr>
</tbody>
</table>
Establishing Loading Functions

MDOF-NONLIN provides three methods for entering loading functions into the model:

1) Simple impulsive loads, more complex load histories, as well as ground accelerations, may be entered through the use of the loading panel at the bottom left of the main MDOF-NONLIN window as shown in Figure 30 below. These functions are identical to those used in the SDOF environment of NONLIN. The advantage of this method is that response spectra and Fourier amplitude spectra may be obtained for the input records.

![Dynamic Force Applied As...](image)

Figure 30 The Loading Panel for Establishing Load Functions

2) As with the SDOF version of NONLIN, the Quik Quake and Quik Wave items on the tool bar may be used as a shortcut to method (1) above.

Both the methods are thoroughly discussed in Part 1 of this manual.
Running the Analysis

After all the structural and loading information has been set, the analysis may be carried out. To do so, click the analysis button on the toolbar. The analysis box then opens, as shown in Figure 31.

The only data to enter are the number of substeps per loadstep, and the analysis duration. By default, the number of analysis substeps is set to 5. The analysis timestep should not be greater than about 1/10 the highest mode to be used in the analysis. For nonlinear analysis, it is recommended that the analysis timestep be not greater than about 0.002 seconds. For a loading with a 0.01 second digitization interval, the number of substeps required would be 5. After the data is entered, click SET ANALYSIS PARAMETERS, and then COMPUTE RESPONSE. A progress bar will indicate that the analysis is being performed. When the analysis is done, close the analysis box and review the results.

Viewing the Results

After the analysis has been completed, you may plot time histories or force-deformation results. These plots are accessed through the appropriate buttons on the tool bar. Example plots are shown in Figures 32 and 33. The items to be plotted are controlled by option buttons on the
plotting panel, or by using the plot captions shown in the list boxes. Plots may be printed by use of the File menu item.

Figure 32  A Typical Time-History Plot

Figure 33  A Typical Hysteresis Plot
Saving Data to File

Any MDOF-NONLIN session may be saved to disk upon exiting the program. Similarly, existing models may be restored by opening the appropriate file. The save/open options are accessed through the File menu.

Returning to NONLIN SDOF Environment

You may switch back to the original NONLIN SDOF environment by clicking SDOF on the Model menu item. Note that there is no data sharing between NONLIN SDOF environment and MDOF-NONLIN.
Part Four

NONLIN - Incremental Dynamic Analysis
Introduction

The Incremental Dynamic Analysis Tool (IDA) allows a single structure to be analyzed for one to twelve earthquakes, with each ground motion being systematically scaled to increasing intensities. For each ground motion considered, X-Y plots and response histories are provided of some response measure versus the intensity measure. The IDA procedure is described in detail by Vamvatsikos (2002a, 2002b).

Accessing the IDA Environment

The IDA environment is accessed in NONLIN by selecting “Inc. Dynamic Analysis” from the main NONLIN form and then pressing the command button. The frame to accomplish this is shown in Figure 34.

Figure 34 Selection of IDA tool from the main NONLIN window

The Incremental Dynamic Analysis form available upon following the above steps is shown in Figure 35. This form consists of three main parts:

1. A ground motion selection and scaling tool (Figure 36)
2. A Structural Properties Input Tool (Figure 37)
3. A Plotting Region, which is the gray area shown at the bottom of the Main IDA form, Figure 35.
Figure 35  Main form for Incremental Dynamic Analysis in NONLIN

Figure 36  Ground motion selection and scaling for IDA analysis

Figure 37  Structural parameters input
Data Input for IDA Analysis

The first step in any IDA analysis is to select the ground motions. Ground motions are simply selected by clicking on the desired motion in the “Available Earthquakes” list to the left, and using the arrow to move the motion to the “Selected Earthquakes” list on the right. If it is desired to remove a particular earthquake from the selected list move it back to the left using the button. All of the motions may be moved to the left at once using the button. Figure 38 shows an updated list with five ground motions selected, but not yet scaled. The default scale factor of 1.0 is shown together with the peak ground acceleration for each earthquake.

Before scaling the ground motions the Target Scaling Parameters must be entered. The basic target scaling parameters are:

- Target Acceleration (g)
- Target Period of Vibration (seconds)
- Target Damping (percent critical)

The Target Acceleration is specified by the user. A good value for this would be the design level pseudo-acceleration from a code-based (e.g. ASCE 7) response spectrum.

Scaling factors are determined such that the peak pseudo-acceleration for a linear SDOF system with the specified target period and specified target damping will be exactly equal to the target spectral acceleration. The Target Period and the Target Damping may be specified by the user, but it is preferred to use the same properties as will be used in the structural analysis. This is the default, and is consistent with the recommendation of Shome and Cornell (1998).

The scaled ground motions are shown in Figure 39. The scale factors are based on the structural parameters shown in Figure 40. Note that the parameters are entered exactly as in the main NONLIN program. If the parameters were entered on the main NONLIN form before invoking...
IDA, the properties will be automatically moved to the IDA form. Similarly, all properties entered on the IDA form will be automatically copied to the main NONLIN form.

The two additional parameters in the ground motion scaling frame are

- Target Multiplier
- Target Increments [maximum = 50]

If, for example, the target acceleration is 0.4G, the target multiplier is 2.0, and the number of increments is 10, ten response histories will be run as follows:

Run 1: Original Motion x Scale Factor x 2.0 x (1/10)
Run 2: Original Motion x Scale Factor x 2.0 x (2/10)
Run 3: Original Motion x Scale Factor x 2.0 x (3/10)
Run 4: Original Motion x Scale Factor x 2.0 x (4/10)
Run 5: Original Motion x Scale Factor x 2.0 x (5/10)
Run 6: Original Motion x Scale Factor x 2.0 x (6/10)
Run 7: Original Motion x Scale Factor x 2.0 x (7/10)
Run 8: Original Motion x Scale Factor x 2.0 x (8/10)
Run 9: Original Motion x Scale Factor x 2.0 x (9/10)
Run 10: Original Motion x Scale Factor x 2.0 x (10/10)

Note that if a linear analysis is executed for run 5, and if the scaling is consistent with the structural parameters, the peak pseudoacceleration from the analysis will be exactly equal to the target acceleration.

**Running the IDA Analysis and Interpreting the Results**

The IDA analysis is initiated by clicking the Run command button.

After doing so a progress bar will appear for each ground motion. Once all of the analyses have been completed, the IDA graphics are presented as shown in Figure 41. The IDA graphics include a large IDA plot and three small response-histories.

The main IDA plot shows the target acceleration on the Y axis and a response measure on the X axis. Currently, the available response parameters are:

- Peak Displacement
- Peak Ductility Demand
- Peak Base Shear
- And Peak Residual Deformation

The first two response histories are fixed, but the third allows the user to plot a variety of items, including yield code.

One of the most useful aspects of the main IDA plot is that the individual response histories from which the IDA values were derived can be viewed by clicking on the IDA plot. The individual response histories may also be advanced by using VCR type buttons:

The final aspect of IDA analysis noted here is that in some cases the displacements from an individual analysis may be extremely large (due to dynamic instability). While this information is useful, for plotting purposes it is necessary to limit the range of the X-axis. This is the purpose of the “Ductility Limit” shown below the scaling frame. The default for this parameter is 10.
The data produced from the IDA analysis may be saved to a tab-delimited file, or the IDA plot may be printed. Use the “Plot” menu on the IDA form to accomplish these tasks. Note that only the main IDA plot is printed. A color plot may be produced if “Color Printing” has been selected from the main NONLIN Parameters menu item.

Figure 41  Completed IDA analysis and graphics presentation of results
Part Five

NONLIN – Dynamic Response Tool
Introduction

The Dynamic Response Tool (DRT) is a utility used to illustrate (in real time) the fundamental concepts of structural dynamics. This illustration is carried out with a multistory shear frame subject to sinusoidal ground excitation. Both the properties of the shear frame and the ground motion may be altered by the user to see how such parameters effect dynamic response.

Accessing the DRT Environment

The DRT tool is accessed by selecting the DRT option from the Model menu command as shown below.

Launching the utility opens the form shown in Figure 42. Four types of data are required to define the shear frame: the number of stories, the stiffness of each story, the mass of each story, and the damping in each mode. All of these values are defined in the Fundamental Properties section located on the left-hand side of the form.

Figure 42 Appearance of the DRT Tools at Startup
Input Parameters for DRT Tool

The number of stories should be defined first, as this variable sets the number of rows in the two tables on the left. After the number of stories has been defined, use the grid controls to specify each story's stiffness and mass as well as the damping associated with each mode.

Once all of the fundamental values are declared, press the Compute Fundamentals button to continue. Pressing this button locks the basic properties of the model and computes the natural periods of the structure. The table in the middle of the form lists the natural periods and an image of the structure is drawn in the large plotting window. Results may also be viewed, as indicated by the change in status of various controls on the form.

Viewing the Results

Two types of results may be reviewed: natural mode shapes and response to ground excitation. Response to ground motion is the default item to review. As the controls on the right side indicate, the ground motion will have frequency equal to the fundamental frequency of the structure and amplitude that varies with the forcing frequency.

The frequency of the loading function may be adjusted by moving the slider bar. Note that a yellow line moves across the plot window as the slider bar is repositioned. This yellow line indicates the frequency of the forcing function while the green lines correspond to the structure's natural frequencies. Loading frequencies may vary from one-half the lowest natural frequency of the structure to twice the largest natural frequency of the structure.

The two VCR style buttons immediately below the slider bar are used to set resonant loading conditions. These buttons should be used to enforce resonant loading as the slider bar may not provide enough accuracy to induce true resonance. Note that the yellow line indicating the forcing frequency turns red whenever resonance is occurring.

By default, the amplitude of the ground excitation varies with the frequency of the forcing function. This variation is nonlinear, as the amplitude increases as the square of the forcing frequency. To manually set the amplitude, remove the check mark in this frame and enter a value in the amplitude text box.

The response to the specified loading may be viewed by pressing the Animate Response button. Pressing this button animates the displacement time history of the frame in the main plot window. The small plot window on the bottom, right-hand side of the form displays the instantaneous Fourier Amplitude Spectrum of structural response. Since the FFT algorithm requires an input vector of 256 points, the spectrum cannot be computed until 128 solution points have been calculated. Once 128 solution points have been computed, the FFT is performed using the past 128 points and the upcoming 128 points. The green lines in the Fourier Amplitude
Spectrum correspond to the structure's natural frequencies. Figure 43 illustrates what the utility will look like when animating response.

Figure 43  Appearance of the program when animating dynamic response

The Dynamic Response Tool can also animate the displacement time history of the roof. Activate this feature by placing a check mark in the box entitled "Show roof displacement time history". Checking this box replaces the grid showing natural periods and frequencies with a black plot window. A trace of the roof displacement is plotted in this window when the user animates the displacement response. Figure 44 shows a snapshot of the program with this feature active.
In addition to animating the response to ground excitation, this utility can also display the natural mode shapes. First select the Show Mode Shapes option in the Results Display frame. Next use the two VCR-style buttons to cycle through the mode shapes. One button displays the next mode shape and the other button displays the previous mode shape. To animate any of the mode shapes, press the Animate Modes button below the text box. Figure 45 shows the utility during a mode animation sequence.
Figure 45  Appearance of the program when animating mode shapes. Animation of the third mode shown here.
References


Acknowledgements

NONLIN was developed by Dr. Finley A. Charney of Advanced Structural Concepts, Denver, Colorado. The developer would like to thank Mr. Michael Valley of J.R. Harris & Company, Denver, Colorado, for his assistance in verifying the results of the program, and for making helpful suggestions throughout the development process. Coding of the program was produced by Dr. Finley Charney and Mr. Brian Barngrover. Mr. Scott Harper and Mr. Riaz Syed assisted in the writing of the manual. Funding was provided through a grant from the Federal Emergency Management Agency (FEMA).

NONLIN was written in Microsoft Visual Basic Professional Version 6.0. The files MHPFST.VBX and MHRUN400.DLL are part of the IOTech VisuaLab-GUI system.

MDOF-NONLIN was developed by Schnabel Engineering Associates, Inc. Of Denver, Colorado, in association with and Advanced Structural Concepts, Inc. of Golden, Colorado. The program was designed by Finley A. Charney, Ph.D., P.E., and was programmed by Dr. Charney, Mr.Brian Barngrover, and Mr. Jeff Dobmeier using Microsoft Visual Basic. Funding for the project was provided by the Federal Emergency Management Agency. The program was reviewed by Mr. Tim Sheckler and Dr. Robert Hanson, both with FEMA. The project was contracted and managed through Woodward Clyde Federal Services. Mr. David Fenster served as the contract coordinator.

The developers would like to thank Professor Steve Mahin of the University of California at Berkeley for providing initial support for the project, and Professor Andrei Reinhorn of the University of New York at Buffalo for providing source code for the multilinear and smooth models employed in the program. Special thanks are due to M.V. Sivaselvan of the University of New York at Buffalo for assisting the developers in the implementation of the hysteretic models.
## Appendix A

### Summary of Ground Motion Records Supplied with NONLIN

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>impval1.acc</td>
<td>Imperial Valley El Centro May 18, 1940 270 degrees</td>
<td>3417.0</td>
<td>32.323</td>
<td>10.86</td>
<td>2688</td>
<td>53.74</td>
</tr>
<tr>
<td>impval2.acc</td>
<td>Imperial Valley El Centro May 18, 1940 180 degrees</td>
<td>2101.0</td>
<td>-36.473</td>
<td>-19.783</td>
<td>2674</td>
<td>53.46</td>
</tr>
<tr>
<td>mexcit1.acc</td>
<td>Mexico City Station 1 September 19, 1985 270 degrees</td>
<td>-97.965</td>
<td>38.739</td>
<td>19.123</td>
<td>9006</td>
<td>180.1</td>
</tr>
<tr>
<td>mexcit2.acc</td>
<td>Mexico City Station 1 September 19, 1985 180 degrees</td>
<td>-167.92</td>
<td>-60.499</td>
<td>21.936</td>
<td>9006</td>
<td>180.1</td>
</tr>
<tr>
<td>nridge2.acc</td>
<td>Northridge Santa Monica, City Hall Grounds January 17, 1994 90 degrees</td>
<td>-865.97</td>
<td>41.751</td>
<td>-14.316</td>
<td>3000</td>
<td>59.98</td>
</tr>
</tbody>
</table>
Summary of Ground Motion Records Supplied with NONLIN (continued)

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>nridge3.acc</td>
<td>Northridge Arleta and Nordhoff Fire Station January 17, 1994 90 degrees</td>
<td>337.318</td>
<td>-40.362</td>
<td>8.878</td>
<td>3000</td>
<td>59.98</td>
</tr>
<tr>
<td>pacoima1.acc</td>
<td>San Fernando Pocoima Dam February 9, 1971 196 degrees</td>
<td>1054.9</td>
<td>-57.499</td>
<td>-10.801</td>
<td>2086</td>
<td>41.70</td>
</tr>
<tr>
<td>pacoima2.acc</td>
<td>San Fernando Pocoima Dam February 9, 1971 286 degrees</td>
<td>-1148.1</td>
<td>-113.23</td>
<td>37.538</td>
<td>2091</td>
<td>41.80</td>
</tr>
<tr>
<td>Park040.acc</td>
<td>Parkfield Cholame, Shandon June 27, 1966 40 degrees</td>
<td>-232.60</td>
<td>10.842</td>
<td>4.41</td>
<td>1310</td>
<td>26.18</td>
</tr>
<tr>
<td>Park130.acc</td>
<td>Parkfield Cholame, Shandon June 27, 1966 130 degrees</td>
<td>-269.60</td>
<td>11.759</td>
<td>-3.933</td>
<td>1308</td>
<td>26.14</td>
</tr>
<tr>
<td>sanfern1.acc</td>
<td>San Fernando 8244 Orion Blvd. February 9, 1971 90 degrees</td>
<td>-250.0</td>
<td>-29.745</td>
<td>-14.789</td>
<td>2975</td>
<td>59.48</td>
</tr>
</tbody>
</table>
Summary of Ground Motion Records Supplied with NONLIN (continued)

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>sanfern2.acc</td>
<td>San Fernando 8244 Orion Blvd. February 9, 1971</td>
<td>-131.7</td>
<td>23.933</td>
<td>13.843</td>
<td>2980</td>
<td>59.58</td>
</tr>
<tr>
<td>s_monica1.acc</td>
<td>Northridge Santa Monica City Hall Grounds January 17, 1994 90 degrees</td>
<td>-865.97</td>
<td>41.751</td>
<td>-14.316</td>
<td>3000</td>
<td>59.98</td>
</tr>
<tr>
<td>s_monica2.acc</td>
<td>Northridge Santa Monica City Hall Grounds January 17, 1994 0 degrees</td>
<td>-362.93</td>
<td>24.910</td>
<td>6.525</td>
<td>3000</td>
<td>59.98</td>
</tr>
<tr>
<td>whitt03.acc</td>
<td>Whittier Fremont School October 1, 1987 180 degrees</td>
<td>286.159</td>
<td>-21.718</td>
<td>-2.443</td>
<td>2000</td>
<td>39.98</td>
</tr>
</tbody>
</table>

Note: The distribution diskette that came with your version of NONLIN may have more or less earthquake records than are indicated in this table.
Appendix B

Format of NONLIN Acceleration Records

NONLIN comes with a selection of earthquake accelerograms taken from a variety of sources. Each acceleration record consists of the following lines of data:

\[
\begin{align*}
\text{nitles} \\
\text{“title 1”} \\
\text{“title 2”} \\
\text{.} \\
\text{.} \\
\text{“title ntitles”} \\
\text{nacc dtacc nplacc unitacc} \\
\text{nvel dtvel nplvel unitvel} \\
\text{ndis dtidis npldis unitdis} \\
\text{Acceleration header} \\
\text{nacc acceleration values, nplacc values per line} \\
\text{Velocity header} \\
\text{nvel velocity values, nplvel values per line} \\
\text{Displacement header} \\
\text{ndis displacement values, npldis values per line}
\end{align*}
\]

The first line contains the entry ntitles, which designates how many title lines follow. Each title line must be in double quotation marks. NONLIN uses the first title line as a descriptor for each plot produced.

Following the title lines are three lines listing the number, timestep, number of values per line, and length units used for the following acceleration, velocity, and displacement data blocks which are listed below. Each data block begins with a header, which is read but otherwise ignored by NONLIN.

An partial listing of the file LOMAP1.ACC is given ahead. The lines with “.” in column 1 indicate data that was eliminated from the record for brevity.
Example Acceleration Record for Loma Prieta Earthquake:

4
"LOMA PRIETA EARTHQUAKE - OAKLAND OUTER HARBOR WHARF"
"OCTOBER 17, 1989, 17:04 PDT"
"CORRECTED ACCELEROMETER, CHANNEL 1, 270 DEGREES, CDMG QL89A472 "
"SOURCE: NISEE, U.C. BERKELEY, CALIFORNIA"
2000 0.02 8 CM
2000 0.02 8 CM
2000 POINTS OF ACCEL DATA EQUALLY SPACED AT .020 SEC. (UNITS: CM/SEC/SEC)
-1.153 -4.317 -5.423 -6.067 -4.769 -.936 3.444 7.283
.
.
.
2000 POINTS OF VELOC DATA EQUALLY SPACED AT .020 SEC. (UNITS: CM/SEC)
  .106 -.136 -.139 -.137 -.126 -.081 -.014 .047
  .060 .006 -.091 -.206 -.313 -.370 -.344 -.236
- .072 .086 .188 .253 .297 .313 .334 .358
.
.
.
  .395 .484 .561 .558 .449 .274 .049 -.182
2000 POINTS OF DISPL DATA EQUALLY SPACED AT .020 SEC. (UNITS: CM)
  -.021 -.023 -.026 -.029 -.032 -.034 -.035 -.035
  -.034 -.033 -.034 -.037 -.042 -.049 -.056 -.062
  -.065 -.065 -.062 -.058 -.052 -.046 -.040 -.032
.
.
.
  -.025 -.016 -.005 .006 .016 .024 .027 .026
End of File
Index

.A

.NLN file · 7
.XL1 · 2
.XL2 · 2, 47
.XL3 · 2

A

acceleration · 17, 25, 26, 27, 28, 98
acceleration records · 11
accelerogram · 2, 25, 26, 27
amplitude · 89
Amplitude · 2, 11, 37
ANIMATE BUTTON · 15
Animation · 49, 50, 51

B

backbone curve · 57
Base-isolated braced frame · 54
Base-isolated braced frame with device · 54
Base-isolated frame · 54
Bauschinger effect · 57
Bilinear · 57, 67
BILINEAR · 56
brace · 72
Braced frame · 54
Braced frame with device · 54
Button Bar · 13

C

Chevron brace · 54
Compute Spectrum · 30
Computed Energy Plots · 8, 14
Computed Hysteresis Plots · 2, 14
COMPUTED HYSTERESIS PLOTS · 42, 44, 45
Computed Time Histories · 2, 7, 14
constant average acceleration technique · 60
Constitutive Properties · 16, 17
CREATE FILE · 8
Create File option · 8
CREATE LOAD · 70
Critical damping · 18

D

damping · 2, 8, 10, 14, 17, 18, 29, 30, 38, 45, 46, 54, 55, 56, 59, 68, 70, 73, 74, 83, 88, 89
Damping · 59
DAMPING · 10, 17, 18
damping coefficient · 68
Device · 70
diagonal mass matrix · 55
displacement · 14, 18, 20, 25, 27, 28, 98
DRT · 5, 88, 89
Ductility Limit · 86
Duration · 11, 37, 95, 96, 97
dynamic · 2, 11, 12, 17, 19, 24, 41, 50
dynamic equilibrium equations · 60
Dynamic Force · 16, 24, 36
Dynamic Force Applied As · 12
Dynamic Properties · 74
Dynamic Response Tool · 88

E
earthquake · 2, 10, 14, 17, 19, 24, 25, 27, 35, 97, 98
Effective initial stiffness · 21
Effective yield Strength · 22
elastic/inelastic spring · 54
energy dissipation · 2
Energy Plots · 46
Entering Structural Properties · 10
equilibrium · 59

F
FAS · 35
FFT · 35, 36, 90
FFT Plot · 38
File menu · 7, 8, 9, 13, 28, 38, 44, 46, 47, 48
Force Units · 16, 17
Fourier Amplitude Spectrum · 90
free vibration · 24, 37, 38
Free Vibration · 38
frequency content · 27
Fundamental Properties · 88

G
GO/NO GO · 13
Ground Acceleration · 24, 27
ground motion · 35

H
HELP menu · 13
Hysteretic Modeling · 56
hysteretic models · 53

I
IDA · 5, 81, 82, 83, 84, 85, 86
Incremental Dynamic Analysis · 5, 80, 81, 82, 93
initial stiffness · 18, 19, 20, 21
INITIAL STIFFNESS · 17, 19
INPUT DAMPING AS · 10
INPUT MASS AS · 9
isolator · 55
Isolator · 70

L

Length Units · 16, 17
linear · 2, 17, 22, 24, 36, 41, 48
LINEAR · 56
linear viscous dashpot · 59
Linear/Nonlinear Analysis · 22
Load Functions · 76
Load histories · 60
Loading Functions · 76
Loading Panel · 76
logarithmic plot · 29

M

m · 54
mass · 10, 12, 17, 18, 19, 54, 55, 56, 63, 64, 66, 68, 73, 88, 89
MASS · 9, 17, 18
MDOF-NONLIN · 5, 53, 54, 57, 58, 59, 60, 61, 62, 63, 64, 73, 74, 76, 79, 94
Menu Items · 7
Microsoft Windows · 2
mode shape · 91
multilinear · 53, 54, 56, 57, 58, 94
Multilinear · 68, 70
MULTILINEAR · 56

N

Newtons · 17
NONLIN · 1, 2, 4, 5, 6, 1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 13, 14, 15, 16, 17, 18, 19, 24, 25, 26, 28, 30, 33, 34, 35, 38, 40, 41, 44, 49,
51, 52, 53, 60, 61, 63, 64, 65, 67, 68, 76, 79, 80, 81, 82, 84, 86, 87, 94, 95, 96, 97, 98
NONLIN.OUT · 2, 15, 48
NONLIN.XL1 · 8
NONLIN.XL2 · 8
nonlinear · 2, 17, 19, 20, 21, 22, 41, 48
Nyquist frequency · 36

P

Paint · 51
PARAMETERS · 7, 9, 18
P-Delta · 4, 2, 20, 21, 53, 54, 55, 62, 63, 73
P-Delta effects · 2, 21, 53
P-Delta stiffness · 21
P-Delta Stiffness · 20
Peak Base Shear · 85
Peak Displacement · 85
Peak Ductility Demand · 85
Peak Residual Deformation · 85
PERFORM TEST · 70
Period · 11, 37
pinching · 57
Plot Spectrum · 30
plots · 35
Point of Application · 38
Print Form · 14, 15, 28, 38, 44, 46
PRINT FORM · 14, 15, 28, 38
pseudo velocity · 30

Q
QUIK QUAKE · 7, 10
QUIK WAVE · 7, 11, 12

R
radio button · 50
Random Noise Frame · 37
RESIZE · 44, 45
response · 15, 19, 20, 27, 28, 29, 38
response spectra · 28
Results · 8, 15, 41, 49, 51
RUN0 · 41

S
scaled ground motions · 84
SDOF · 4, 5, 40, 62, 64, 76, 79, 83
secondary stiffness · 2, 20, 21, 22
SECONDARY STIFFNESS · 17, 20
Signal Description · 37
Signal Length · 37
Simple bilinear · 57
slider · 50
SMOOTH hysteresis · 56
Spectral Coordinates · 30, 31
START ANALYSIS BUTTONS · 13
Startup Ramp Frame · 37
STEP FACTOR X · 9
stiffness matrix · 55
strain hardening · 2, 20, 21
Strain Hardening Stiffness · 20
structural energy · 14
Structural Properties · 66
STRUCTURE PROPERTIES INPUT · 6, 12, 13, 16, 23, 25, 41
STRUCTURE RESTORE BUTTON · 13
Structure Type · 65
Summary of Computed Results · 8, 15

T
tangent stiffnesses · 55
Target Acceleration · 83
Target Damping · 83
Target Increments · 84
Target Multiplier · 84
Target Period of Vibration · 83
the **EARTHQUAKE GROUND ACCELERATION INPUT** frame · 25
The Menu Bar · 62
the **STRUCTURE PROPERTIES INPUT** · 7, 9, 10, 11
Tool Bar · 65
Trilinear · 57
Tripartite · 29, 30, 31

---

**U**

Units · 63, 64

---

**V**

VCR style buttons · 89
VCR type buttons · 85
velocity · 25, 27, 28, 98
velocity exponent · 71
Vertex oriented · 57
**VIEW menu** · 12

---

**W**

Wave Forcing Function · 36
**WAVE GENERATOR** · 12, 36, 37, 38
window · 35
**WINDOW menu** · 12
Windows Clipboard · 51
WordPad · 2

---

**Y**

YIELD STRENGTH · 17, 22